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Overview

Agisoft PhotoScan is an advanced image-based 3D modeling solution aimed at creating professional
quality 3D content from still images. Based on the latest multi-view 3D reconstruction technology, it
operates with arbitrary images and is efficient in both controlled and uncontrolled conditions. Photos can
be taken from any position, providing that the object to be reconstructed is visible on at least two photos.
Both image alignment and 3D model reconstruction are fully automated.

How it works

Generaly the final goal of photographs processing with PhotoScan is to build a textured 3D model. The
procedure of photographs processing and 3D model construction comprises four main stages.

1. Thefirst stageiscameraalignment. At this stage PhotoScan searchesfor common points on photographs
and matches them, as well as it finds the position of the camera for each picture and refines camera
calibration parameters. As aresult a sparse point cloud and a set of camera positions are formed.

The sparse point cloud represents the results of photo aignment and will not be directly used in
the further 3D model construction procedure (except for the sparse point cloud based reconstruction
method). However it can be exported for further usage in external programs. For instance, the sparse
point cloud model can be used in a 3D editor as areference.

On the contrary, the set of camera positions is required for further 3D model reconstruction by
PhotoScan.

2. The next stage is building dense point cloud. Based on the estimated camera positions and pictures
themselves a dense point cloud is built by PhotoScan. Dense point cloud may be edited and classified
prior to export or proceeding to 3D mesh model generation.

3. Thethird stage is building mesh. PhotoScan reconstructs a 3D polygona mesh representing the object
surface based on the dense or sparse point cloud according to the user's choice. Generally there are two
algorithmic methods available in PhotoScan that can be applied to 3D mesh generation: Height Field
- for planar type surfaces, Arbitrary - for any kind of object.

The mesh having been built, it may be necessary to edit it. Some corrections, such as mesh decimation,
removal of detached components, closing of holes in the mesh, smoothing, etc. can be performed by
PhotoScan. For more complex editing you have to engage external 3D editor tools. PhotoScan allows
to export mesh, edit it by another software and import it back.

4. After geometry (i.e. mesh) isreconstructed, it can be textured and/or used for orthomosaic generation.
Several texturing modes are available in PhotoScan, they are described in the corresponding section of
this manual, as well as orthomosaic and DEM generation procedures.

About the manual

Basically, the sequence of actions described above covers most of the data processing needs. All these
operations are carried out automatically according to the parameters set by user. Instructions on how to
get through these operations and descriptions of the parameters controlling each step are given in the
corresponding sections of the Chapter 3, General workflow chapter of the manual.

In some cases, however, additional actions may be required to get the desired results. In some capturing
scenarios masking of certain regions of the photos may be required to exclude them from the cal cul ations.
Application of masksin PhotoScan processing workflow aswell as editing options available are described
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in Chapter 6, Editing. Camera calibration issues are discussed in Chapter 4, Referencing, that also
describes functionality to optimize cameraalignment results and provides guidance on model referencing.
A referenced model, be it amesh or aDEM serves as a ground for measurements. Area, volume, profile
measurement procedures are tackled in Chapter 5, Measurements, which also includes information on
vegetation indices cal culations. While Chapter 7, Automation describes opportunitiesto save up on manual
intervention to the processing workflow, Chapter 8, Network processing presents guidelines on how to
organize distributed processing of the imagery data on several nodes.

It can take up quite along time to reconstruct a 3D model. PhotoScan allows to export obtained results
and save intermediate datain aform of project files at any stage of the process. If you are not familiar with
the concept of projects, its brief description is given at the end of the Chapter 3, General workflow.

In the manual you can also find instructions on the PhotoScan installation procedure and basic rules for
taking "good" photographs, i.e. pictures that provide most necessary information for 3D reconstruction.
For the information refer to Chapter 1, Installation and Chapter 2, Capturing photos.

Vi



Chapter 1. Installation

System requirements

Minimal configuration
» Windows XP or later (32 or 64 bit), Mac OS X Snow Leopard or later, Debian/Ubuntu (64 bit)
¢ Intel Core 2 Duo processor or equivalent

+ 2GB of RAM

Recommended configuration

» Windows XP or later (64 bit), Mac OS X Snow Leopard or later, Debian/Ubuntu (64 bit)
* Intel Corei7 processor

* 12GB of RAM

The number of photos that can be processed by PhotoScan depends on the available RAM and
reconstruction parameters used. Assuming that a single photo resolution is of the order of 10 MPix, 2GB
RAM is sufficient to make a model based on 20 to 30 photos. 12GB RAM will alow to process up to
200-300 photographs.

OpenCL acceleration

PhotoScan supports accel erated depth maps reconstruction due to the graphics hardware (GPU) exploiting.
NVidia
GeForce 8xxx series and later.

ATI
Radeon HD 5xxx series and later.

PhotoScan is likely to be able to utilize processing power of any OpenCL enabled device during Dense
Point Cloud generation stage, provided that OpenCL driversfor thedeviceare properly installed. However,
because of thelarge number of vari ous combinations of video chips, driver versionsand operating systems,
Agisoft isunableto test and guarantee PhotoScan's compatibility with every device and on every platform.

The table below lists currently supported devices (on Windows platform only). We will pay particular
attention to possible problems with PhotoScan running on these devices.

Table 1.1. Supported Desktop GPUs on Windows platform

NVIDIA AMD

Quadro M6000 Radeon R9 290x
GeForce GTX TITAN Radeon HD 7970
GeForce GTX 980 Radeon HD 6970
GeForce GTX 780 Radeon HD 6950
GeForce GTX 680 Radeon HD 6870




NVIDIA AMD

GeForce GTX 580 Radeon HD 5870
GeForce GTX 570 Radeon HD 5850
GeForce GTX 560 Radeon HD 5830

GeForce GTX 480
GeForce GTX 470
GeForce GTX 465
GeForce GTX 285
GeForce GTX 280

Although PhotoScan is supposed to be able to utilize other GPU models and being run under a different
operating system, Agisoft does not guarantee that it will work correctly.

4 Note

« OpenCL acceleration can be enabled using OpenCL tab in the Preferences dialog box. For each
OpenCL device used, one physical CPU core should be disabled for optimal performance.

» Using OpenCL acceleration with mobile or integrated graphics video chipsis not recommended
because of the low performance of such GPUs.

Installation procedure

Installing PhotoScan on Microsoft Windows

To install PhotoScan on Microsoft Windows simply run the downloaded ms file and follow the
instructions.

Installing PhotoScan on Mac OS X

Open the downloaded dmg image and drag PhotoScan application to the desired location on your hard
drive.

Installing PhotoScan on Debian/Ubuntu

Unpack the downl oaded archive with aprogram distribution kit to the desired location on your hard drive.
Start PhotoScan by running photoscan.sh script from the program folder.

Restrictions of the Demo mode

Once PhotoScan is downloaded and installed on your computer you can run it either in the Demo mode
or in the full function mode. On every start until you enter a serial number it will show a registration
box offering two options: (1) use PhotoScan in the Demo mode or (2) enter a serial number to confirm
the purchase. The first choice is set by default, so if you are still exploring PhotoScan click the Continue
button and PhotoScan will start in the Demo mode.

The employment of PhotoScan in the Demo mode is not time limited. Several functions, however, are not
available in the Demo mode. These functions are the following:
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saving the project;

build tiled model;

build orthomosaic;

build DEM;

DEM and orthomosaic related features (such as Raster Calculator, DEM-based measurements);
some Python commands.

exporting reconstruction results (you can only view a 3D model on the screen);

To use PhotoScan in the full function mode you have to purchase it. On purchasing you will get the serial
number to enter into the registration box on starting PhotoScan. Once the serial number is entered the
registration box will not appear again and you will get full accessto al functions of the program.




Chapter 2. Capturing photos

Before loading your photographs into PhotoScan you need to take them and select those suitable for 3D
model reconstruction.

Photographs can be taken by any digital camera (both metric and non-metric), aslong as you follow some
specific capturing guidelines. This section explains general principles of taking and selecting pictures that
provide the most appropriate data for 3D model generation.

IMPORTANT! Make sure you have studied the following rules and read the list of restrictions before you
get out for shooting photographs.

Equipment

Use adigital camera with reasonably high resolution (5 MPix or more).

Avoid ultra-wide angle and fisheye lenses. The best choice is 50 mm focal length (35 mm film
equivalent) lenses. It isrecommended to usefocal length from 20 to 80 mm interval in 35mm equivalent.
If a data set was captured with fisheye lens, appropriate camera sensor type should be selected in
PhotoScan Camera Calibration dialog prior to processing.

Fixed lenses are preferred. If zoom lenses are used - focal length should be set either to maximal or to
minimal value during the entire shooting session for more stable results.

Camera settings

Using RAW data losslessly converted to the TIFF files is preferred, since JPG compression induces
unwanted noise to the images.

Take images at maximal possible resolution.
ISO should be set to the lowest value, otherwise high 1 SO values will induce additional noise to images.

Aperture value should be high enough to result in sufficient focal depth: it isimportant to capture sharp,
not blurred photos.

Shutter speed should not be too slow, otherwise blur can occur due to slight movements.

Object/scene requirements

Avoid not textured, shiny, mirror or transparent objects.

If still have to, shoot shiny objects under a cloudy sky.
Avoid unwanted foregrounds.

Avoid moving objects within the scene to be reconstructed.

Avoid absolutely flat objects or scenes.

Image preprocessing

PhotoScan operates with the original images. So do not crop or geometrically transform, i.e. resize or
rotate, the images.
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Capturing scenarios

Generally, spending some time planning your shot session might be very useful.

Number of photos: more than required is better than not enough.

Number of "blind-zones' should be minimized since PhotoScan is able to reconstruct only geometry
visible from at least two cameras.

In case of aeria photography the overlap requirement can be put in the following figures: 60% of side
overlap + 80% of forward overlap.

Each photo should effectively use the frame size: object of interest should take up the maximum area.
In some cases portrait camera orientation should be used.

Do not try to place full object in theimage frame, if some partsare missing it isnot aproblem providing
that these parts appear on other images.

Good lighting is required to achieve better quality of the results, yet blinks should be avoided. It is
recommended to remove sources of light from camerafields of view. Avoid using flash.

If you are planning to carry out any measurements based on the reconstructed model, do not forget to
locate at least two markers with aknown distance between them on the object. Alternatively, you could
place aruler within the shooting area.

In case of aerial photography and demand to fulfil georeferencing task, even spread of ground control
points (GCPs) (at least 10 across the area to be reconstructed) is required to achieve results of highest
quality, bothin terms of the geometrical precision and georeferencing accuracy. Y et, Agisoft PhotoScan
is able to complete the reconstruction and georeferencing tasks without GCPs, too.

The following figures represent advice on appropriate capturing scenarios:

Facade (Incorrect) Facade (Correct)
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In some cases it might be very difficult or even impossible to build a correct 3D model from a set of
pictures. A short list of typical reasons for photographs unsuitability is given below.

Modifications of photographs

PhotoScan can process only unmodified photos as they were taken by a digital photo camera. Processing
the photos which were manually cropped or geometrically warped is likely to fail or to produce highly
inaccurate results. Photometric modifications do not affect reconstruction results.

Lack of EXIF data

To estimatethe field of view for each photo PhotoScan uses the information saved in the EXIF part of each
picture. If EXIF data are available you can expect to get the best possible 3D reconstruction. However
3D scene can aso be reconstructed in the absence of EXIF data. In this case PhotoScan assumes that
focal length in 35 mm equivalent equals to 50 mm and tries to align the photos in accordance with this
assumption. If the correct focal length value differs significantly from 50 mm, the alignment can give
incorrect results or even fail. In such casesit isrequired to specify initial camera calibration manually.

The details of necessary EXIF tags and instructions for manual setting of the calibration parameters are

given in the Camera calibration section.
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Lens distortion

The distortion of the lenses used to capture the photos should be well simulated with the Brown'sdistortion
model. Otherwise it ismost unlikely that processing results will be accurate. Fisheye and ultra-wide angle
lenses are poorly modeled by the common distortion model implemented in PhotoScan software, so it is
required to choose proper cameratype in Camera Calibration dialog prior to processing.




Chapter 3. General workflow

Processing of images with PhotoScan includes the following main steps:
* loading photos into PhotoScan;

* inspecting loaded images, removing unnecessary images,
« aligning photos;

* building dense point cloud;

* building mesh (3D polygonal model);

* generating texture;

* building tiled model;

* building digital elevation model;

* building orthomosaic;

* exporting results.

If you are using PhotoScan in the full function (not the Demo) mode, intermediate results of the image
processing can be saved at any stage in the form of project files and can be used later. The concept of
projects and project filesis briefly explained in the Saving intermediate results section.

The list above represents al the necessary steps involved in the construction of a textured 3D model
DEM and orthomosaic from your photos. Some additional tools, which you may find to be useful, are
described in the successive chapters.

Preferences settings

Before starting a project with PhotoScan it is recommended to adjust the program settings for your needs.
In Preferences dialog (General Tab) available through the Tools menu you can indicate the path to the
PhotoScan log file to be shared with the Agisoft support team in case you face any problem during the
processing. Here you can al so change GUI language to the onethat is most convenient for you. The options
are: English, Chinese, French, German, Japanese, Portuguese, Russian, Spanish.

On the OpenCL Tab you need to make sure that all OpenCL devices detected by the program are checked.
PhotoScan exploits GPU processing power that speeds up the process significantly. If you have decided
to switch on GPUs for photogrammetric data processing with PhotoScan, it is recommended to free one
physical CPU core per each active GPU for overall control and resource managing tasks.

Loading photos

Before starting any operation it is necessary to point out what photos will be used as a source for 3D
reconstruction. In fact, photographs themselves are not loaded into PhotoScan until they are needed. So,
when you "load photos' you only indicate photographs that will be used for further processing.

Toload a set of photos

L Select Add Photos... command from the Workflow menu or click @ Add Photos toolbar button on

the Workspace pane.




General workflow

2. In the Add Photos dialog box browse to the folder containing the images and select files to be
processed. Then click Open button.

3. Selected photos will appear on the Workspace pane.
4 Note

» PhotoScan accepts the following image formats: JPEG, TIFF, PNG, BMP, PPM, OpenEXR
and JPEG Multi-Picture Format (MPO). Photos in any other format will not be shown in the
Add Photos dialog box. To work with such photos you will need to convert them in one of the
supported formats.

If you have loaded some unwanted photos, you can easily remove them at any moment.

Toremove unwanted photos
1. Onthe Workspace pane select the photos to be removed.

2. Right-click on the selected photos and choose Remove Items command from the opened context

menu, or click X Remove Items toolbar button on the Workspace pane. The selected photos will
be removed from the working set.

Camera groups

If al the photos or a subset of photos were captured from one camera position - camera station, for
PhotoScan to process them correctly it is obligatory to move those photos to a camera group and mark
the group as Camera Station. It is important that for all the photos in a Camera Station group distances
between camera centerswere negligibly small compared to the camera-object minimal distance. 3D model
reconstruction will require at least two camera stations with overlapping photos to be present in a chunk.
However, it is possible to export panoramic picture for the data captured from only one camera station.
Refer to Exporting results section for guidance on panorama export.

Alternatively, camera group structure can be used to manipulate the image datain a chunk easily, e.g. to
apply Disable/Enable functions to all the camerasin agroup at once.

To move photosto a camera group
1. Onthe Workspace pane (or Photos pane) select the photos to be moved.

2. Right-click on the selected photos and choose Move Cameras - New Camera Group command from
the opened context menu.

3. A new group will be added to the active chunk structure and selected photos will be moved to that
group.

4. Alternatively selected photos can be moved to a camera group created earlier using Move Cameras
- Camera Group - Group_name command from the context menu.

To mark group as camera station, right click on the camera group name and select Set Group Type
command from the context menu.

Inspecting loaded photos

Loaded photos are displayed on the Workspace pane along with flags reflecting their status.

The following flags can appear next to the photo name:
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NC (Not calibrated)
Notifies that the EXIF data available is not sufficient to estimate the camerafocal length. In this case
PhotoScan assumes that the corresponding photo was taken using 50mm lens (35mm film equivalent).
If the actual focal length differs significantly from this value, manual calibration may be required.
More details on manual camera calibration can be found in the Camera calibration section.

NA (Not aligned)
Notifiesthat external cameraorientation parameters have not been estimated for the current photo yet.

Images loaded to PhotoScan will not be aligned until you perform the next step - photos alignment.

=)
Notifies that Camera Station type was assigned to the group.

Multispectral imagery

Rigid

PhotoScan supports processing of multispectral images saved as multichannel (single page) TIFF files.
The main processing stages for multispectral images are performed based on the master channel, which
can be selected by the user. During orthophoto export, al spectral bands are processed together to form a
multispectral orthophoto with the same bands as in source images.

The overall procedure for multispectral imagery processing does not differ from the usual procedure for
normal photos, except the additional master channel selection step performed after adding images to the
project. For the best results it is recommended to select the spectral band which is sharp and as much
detailed as possible.

To select master channdl

1. Add multispectral images to the project using Add Photos... command from the Workflow menu or
Add Photos toolbar button.

2. Select Set Master Channel... command from the chunk context menu in the Workspace pane.

3. Inthe Set Master Channel dial og select the channel to be used as master and click OK button. Display
of imagesin PhotoScan window will be updated according to the master channel selection.

4 Note

e Set Master Channel... command is available for RGB images as well. You can either indicate
only one channel to be used as the basis for photogrammetric processing or leave the parameter
value as Default for al three channels to be used in processing.

Multispectral orthomosaic export is supported in GeoTIFF format only. When exporting in other formats,
only master channel will be saved.

camerarigs

PhotoScan supports processing of multispectral datasets captured with multiple synchronized cameras
operating in different spectral ranges. In this case multiple images (planes) are available for each position
and PhotoScan will estimate separate calibration for each plane aswell as their relative orientation within
camerarig.

Multiplane layout is formed at the moment of adding photos to the chunk. It will reflect the data layout
used to store image files. Therefore it is necessary to organize files on the disk appropriately in advance.
The following data layouts can be used with PhotoScan:

10
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a. All image planes from each position are contained in a separate multilayer image. The number of
multilayer imagesis equal to the number of camera positions.

b. Corresponding planes from all camera positions are contained in a separate subfolder. The number of
subfoldersis equal to the number of planes.

c. For aspecial case of MicaSense camera, no special layout is required. In this case the arrangement of
images into cameras and planes will be performed automatically based on available meta data.

Once the data is properly organized, it can be loaded into PhotoScan to form multiplane cameras. The
exact procedure will depend on whether the multilayer layout (variant a), multifolder layout (variant b)
or if MicaSense datais used.

To create a chunk from multilayer images

L Select Add Photos... command from the Workflow menu or click Add Photos toolbar button.

2. Inthe Add Photos dialog box browse to the folder containing multilayer images and select files to
be processed. Then click Open button.

3. Inthe Add Photos dialog select the data layout " Create multispectral cameras from files as cameras”.

4. Created chunk with multispectral cameras will appear on the Workspace pane.

To create a chunk from multifolder layout

L Select & Add Folder... command from the Workflow menu.

2. Inthe Add Folder dialog box browse to the parent folder containing subfolders with images. Then
click Select Folder button.

3. Inthe Add Photos dialog select the data layout " Create multispectral cameras from folders as bands"

4. Created chunk with multispectral cameras will appear on the Workspace pane.

To create a chunk from MicaSense data

L Select Add Photos... command from the Workflow menu or click Add Photos toolbar button.

2. Inthe Add Photos dialog box browse to the folder containing MicaSense images and select files to
be processed. Then click Open button.

3. Inthe Add Photos dialog select " Create multispectral cameras from files as bands'.
4. Created chunk with multispectral cameras will appear on the Workspace pane.

After chunk with multispectral camerasis created, it can be processed in the same way as normal chunks.
For these chunks additional parameters allowing to manipulate the data properly will be provided where

appropriate.

Aligning photos

Once photos are loaded into PhotoScan, they need to be aligned. At this stage PhotoScan finds the camera
position and orientation for each photo and builds a sparse point cloud model.

11
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Toalign a set of photos
1. Select Align Photos... command from the Workflow menu.
2. Inthe Align Photos dialog box select the desired alignment options. Click OK button when done.

3. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

Alignment having been completed, computed camera positions and a sparse point cloud will be displayed.
You can inspect alignment results and remove incorrectly positioned photos, if any. To see the matches
between any two photos use View Matches... command from a photo context menu in the Photos pane.

Incorrectly positioned photos can be realigned.

Torealign a subset of photos

1. Reset aignment for incorrectly positioned cameras using Reset Camera Alignment command from
the photo context menu.

2. Set markers (at least 4 per photo) on these photos and indicate their projections on at least two
photos from the already aligned subset. PhotoScan will consider these points to be true matches. (For
information on markers placement refer to the Setting coordinate system section).

3. Select photosto berealigned and use Align Sel ected Cameras command from the photo context menu.

4. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

When the alignment step is completed, the point cloud and estimated camera positions can be exported
for processing with another software if needed.

Image quality

Poor input, e. g. vague photos, can influence alignment results badly. To help you to exclude poorly
focused images from processing PhotoScan suggests automatic image quality estimation feature. Images
with quality value of less than 0.5 units are recommended to be disabled and thus excluded from
photogrammetric processing, providing that the rest of the photos cover the whole scene to be

reconstructed. To disable a photo use @ Disable button from the Photos pane toolbar.

PhotoScan estimates image quality for each input image. The value of the parameter is cal culated based
on the sharpness level of the most focused part of the picture.

To estimate image quality
L Switch to the detailed view in the Photos pane using == Details command from the Change menu
on the Photos pane toolbar.

2. Select all photos to be analyzed on the Photos pane.

3. Right button click on the selected photo(s) and choose Estimate Image Quality command from the
context menu.

4. Once the analysis procedure is over, a figure indicating estimated image quality value will be
displayed in the Quality column on the Photos pane.

12



General workflow

Alignment parameters

Thefollowing parameters control the photo alignment procedure and can be modified in the Align Photos
dialog box:

Accuracy
Higher accuracy settings help to obtain more accurate camera position estimates. Lower accuracy
settings can be used to get the rough camera positions in a shorter period of time.

While at High accuracy setting the software workswith the photos of the original size, Medium setting
causes image downscaling by factor of 4 (2 times by each side), at Low accuracy source files are
downscaled by factor of 16, and Lowest value means further downscaling by 4 times more. Highest
accuracy setting upscales the image by factor of 4. Since tie point positions are estimated on the
basis of feature spots found on the source images, it may be meaningful to upscale a source photo
to accurately localize atie point. However, Highest accuracy setting is recommended only for very
sharp image data and mostly for research purposes due to the corresponding processing being quite
time consuming.

Pair preselection
Thealignment process of large photo sets cantake along time. A significant portion of thistime period
is spent on matching of detected features across the photos. Image pair presel ection option may speed
up this process due to selection of asubset of image pairsto be matched. Inthe Gener i ¢ preselection
mode the overlapping pairs of photos are selected by matching photos using lower accuracy setting
first.

In the Ref er ence preselection mode the overlapping pairs of photos are selected based on the
measured camera locations (if present). For oblique imagery it is necessary to set Ground altitude
value (average ground height in the same coordinate system which is set for camera coordinates data)
in the Settings dialog of the Reference pane to make the preselection procedure work efficiently.
Ground altitude information must be accompanied with yaw, pitch, roll datafor cameras. Y aw, pitch,
roll data should be input in the Reference pane.

Additionally the following advanced parameters can be adjusted.

Key point limit
The number indicates upper limit of feature points on every image to be taken into account during
current processing stage. Using zero value allows PhotoScan to find as many key points as possible,
but it may result in a big number of lessreliable points.

Tiepoint limit
The number indicates upper limit of matching points for every image. Using zero value doesn't apply
any tie point filtering.

Constrain featur es by mask
When this option is enabled, masked areas are excluded from feature detection procedure. For
additional information on the usage of masks please refer to the Using masks section.

4 Note

e Tie point limit parameter allows to optimize performance for the task and does not generally
effect the quality of the further model. Recommended valueis4000. Too high or too low tie point
limit value may cause some parts of the dense point cloud model to be missed. The reason isthat
PhotoScan generates depth maps only for pairs of photos for which number of matching pointsis
abovecertain limit. Thislimit equalsto 100 matching points, unless moved up by thefigure"10%
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of the maximum number of matching points between the photo in question and other photos,
only matching points corresponding to the area within the bounding box being considered.”

» The number of tie points can be reduced after the alignment process with Tie Points - Thin Point
Cloud command available from Tools menu. As aresults sparse point cloud will be thinned, yet
the alignment will be kept unchanged.

Point cloud generation based on imported camera data

PhotoScan supportsimport of external and internal camera orientation parameters. Thus, if precise camera
data is available for the project, it is possible to load them into PhotoScan along with the photos, to be
used asinitia information for 3D reconstruction job.

Toimport external and internal camera parameters
1. Select Import Cameras command from the Tools menu.

2. Select the format of the file to be imported.

3. Browsetothefile and click Open button.

4. The datawill be loaded into the software. Camera calibration data can be inspected in the Camera
Calibration dialog, Adjusted tab, available from Tools menu. If theinput file contains some reference
data (camera position datain some coordinate system), the datawill be shown on the Reference pane,
View Estimated tab.

Cameradatacan beloaded in one of the following formats: PhotoScan*.xml, BINGO *.dat, Bundler *.out,
VisionMap Detailed Report *.txt, Realviz RZML *.rzml.

Once the data is loaded, PhotoScan will offer to build point cloud. This step involves feature points
detection and matching procedures. As aresult, a sparse point cloud - 3D representation of the tie-points
data, will be generated. Build Point Cloud command isavailable from Tools - Tie Points menu. Parameters
controlling Build Point Cloud procedure are the same as the ones used at Align Photos step (see above).

Building dense point cloud

PhotoScan allows to generate and visualize a dense point cloud model. Based on the estimated camera
positions the program calculates depth information for each camera to be combined into a single dense
point cloud. PhotoScan tends to produce extra dense point clouds, which are of aimost the same density,
if not denser, as LIDAR point clouds. A dense point cloud can be edited and classified within PhotoScan
environment or exported to an external tool for further analysis.

To build adense point cloud

1 Check the reconstruction volume bounding box. To adjust the bounding box usethe %P Resize Region

and 82’ Rotate Region toolbar buttons. Rotate the bounding box and then drag corners of the box to
the desired positions.

2. Select the Build Dense Cloud... command from the Workflow menu.

3. Inthe Build Dense Cloud dialog box select the desired reconstruction parameters. Click OK button
when done.
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4. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

Reconstruction parameters

Quality
Specifiesthe desired reconstruction quality. Higher quality settings can be used to obtain more detailed
and accurate geometry, but they require longer time for processing. Interpretation of the quality
parameters here is similar to that of accuracy settings given in Photo Alignment section. The only
difference is that in this case Ultra High quality setting means processing of original photos, while
each following step implies preliminary image size downscaling by factor of 4 (2 times by each side).

Additionally the following advanced parameters can be adjusted.

Depth Filtering modes
At the stage of dense point cloud generation reconstruction PhotoScan cal cul ates depth mapsfor every
image. Due to some factors, like noisy or badly focused images, there can be some outliers among
the points. To sort out the outliers PhotoScan has severa built-in filtering algorithms that answer the
challenges of different projects.

If there are important small details which are spatially distingueshed in the scene to be
reconstructed, then it is recommended to set M | d depth filtering mode, for important features
not to be sorted out as outliers. This value of the parameter may also be useful for aerial projects
in case the area contains poorly textued roofs, for example.

If the area to be reconstructed does not contain meaningful small details, then it is reasonable
to chose Aggr essi ve depth filtering mode to sort out most of the outliers. This value of the
parameter normally recommended for aerial data processing, however, mild filtering may be
useful in some projects as well (see poorly textured roofs comment in the mild parameter valur
description above).

Moder at e depth filtering mode brings results that are in between the Mild and Aggressive
approaches. Y ou can experiment with the setting in case you have doubts which mode to choose.

Additionally depth filtering can be Di sabl ed. But this option is not recommended as the resulting
dense cloud could be extremely noisy.

Building mesh

To build amesh

1. Check the reconstruction volume bounding box. If the model has aready been referenced, the
bounding box will be properly positioned automatically. Otherwise, it is important to control its
position manually.

To adjust the bounding box manually, use the P Resize Region and gg’ Rotate Region toolbar
buttons. Rotate the bounding box and then drag corners of the box to the desired positions - only part
of the scene inside the bounding box will be reconstructed. If the Hei ght fi el d reconstruction
method is to be applied, it isimportant to control the position of the red side of the bounding box: it
defines reconstruction plane. In this case make sure that the bounding box is correctly oriented.

2. Select the Build Mesh... command from the Workflow menu.

3. Inthe Build Mesh dialog box select the desired reconstruction parameters. Click OK button when
done.
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4. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

Reconstruction parameters

PhotoScan supports several reconstruction methods and settings, which help to produce optimal
reconstructions for a given data set.

Surfacetype

Ar bi t rary surface type can be used for modeling of any kind of object. It should be selected
for closed objects, such as statues, buildings, etc. It doesn't make any assumptions on the type of
the object being modeled, which comes at a cost of higher memory consumption.

Hei ght fi el d surface type is optimized for modeling of planar surfaces, such asterrains or
basereliefs. 1t should be selected for aerial photography processing as it requires lower amount
of memory and alows for larger data sets processing.

Sour ce data
Specifies the source for the mesh generation procedure. Spar se cl oud can be used for fast 3D
model generation based solely on the sparse point cloud. Dense cl oud setting will result in longer
processing time but will generate high quality output based on the previously reconstructed dense
point cloud.

Polygon count

Specifies the maximum number of polygons in the final mesh. Suggested values (High, Medium,
Low) are calculated based on the number of pointsin the previously generated dense point cloud: the
ration is 1/5, 1/15, and 1/45 respectively. They present optimal number of polygons for a mesh of a
corresponding level of detail. It is still possible for a user to indicate the target number of polygons
in the final mesh according to their choice. It could be done through the Custom value of the Polygon
count parameter. Please note that while too small number of polygonsislikely to result in too rough
mesh, too huge custom number (over 10 million polygons) is likely to cause model visualization
problemsin external software.

Additionally the following advanced parameters can be adjusted.
I nterpolation

If interpolation mode is Di sabl ed it leads to accurate reconstruction results since only areas
corresponding to dense point cloud points are reconstructed. Manual hole filling is usually
required at the post processing step.

WithEnabl ed (def aul t) interpolation mode PhotoScan will interpol ate some surface areas
within acircle of a certain radius around every dense cloud point. As aresult some holes can be
automatically covered. Yet some holes can still be present on the model and are to be filled at
the post processing step.

In Ext r apol at ed mode the program generates holeless model with extrapolated geometry.
Large areas of extra geometry might be generated with this method, but they could be easily
removed later using selection and cropping tools.

Point classes
Specifiesthe classes of the dense point cloud to be used for mesh generation. For example, select only
"Ground Points" to produce aDTM as opposed to aDSM. Preliminary Classifying dense cloud points
procedure should be performed for this option of mesh generation to be active.
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4 Note

 PhotoScan tendsto produce 3D model swith excessive geometry resolution, soitisrecommended
to perform mesh decimation after geometry computation. More information on mesh decimation
and other 3D model geometry editing toolsis given in the Editing model geometry section.

Building model texture

To generate 3D model texture
1. Select Build Texture... command from the Workflow menu.

2. Select the desired texture generation parameters in the Build Texture dialog box. Click OK button
when done.

3. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

Texture mapping modes

The texture mapping mode determines how the object texture will be packed in the texture atlas. Proper
texture mapping mode selection helps to obtain optimal texture packing and, consequently, better visual
quality of the final model.

Generic
The default mode isthe Gener i ¢ mapping mode; it allows to parametrize texture atlas for arbitrary
geometry. No assumptions regarding the type of the scene to be processed are made; program tries
to create as uniform texture as possible.

Adaptive orthophoto
In the Adapti ve orthophot o mapping mode the object surface is split into the flat part and
vertical regions. Theflat part of the surfaceistextured using the orthographic projection, whilevertical
regions are textured separately to maintain accurate texture representation in such regions. When in
the Adapti ve orthophot o mapping mode, program tends to produce more compact texture
representation for nearly planar scenes, while maintaining good texture quality for vertical surfaces,
such aswalls of the buildings.

Orthophoto
In the Ort hophot o mapping mode the whole object surface is textured in the orthographic
projection. The Ort hophot o mapping mode produces even more compact texture representation
than the Adapt i ve ort hophot o mode at the expense of texture quality in vertical regions.

Spherical
Spher i cal mapping modeisappropriate only to acertain class of objectsthat have aball-likeform.
It allows for continuous texture atlas being exported for this type of objects, so that it is much easier
to edit it later. When generating texture in Spherical mapping mode it is crucial to set the Bounding
box properly. The whole model should be within the Bounding box. The red side of the Bounding
box should be under the model; it defines the axis of the spherical projection. The marks on the front
side determine the O meridian.

Single photo
The Si ngl e phot o mapping mode allows to generate texture from a single photo. The photo to be
used for texturing can be selected from 'Texture from' list.

17



General workflow

Keep uv
The Keep uv mapping mode generates texture atlas using current texture parametrization. It can
be used to rebuild texture atlas using different resolution or to generate the atlas for the model
parametrized in the external software.

Texture gen eration parameters

The following parameters control various aspects of texture atlas generation:

Texturefrom (Single photo mapping mode only)
Specifies the photo to be used for texturing. Available only in the Si ngl e phot o mapping mode.

Blending mode (not used in Single photo mode)
Selects the way how pixel values from different photos will be combined in the final texture.

Mosai ¢ - implies two-step approach: it does blending of low frequency component for overlapping
images to avoid seamline problem (weighted average, weight being dependent on a number of
parameters including proximity of the pixel in question to the center of the image), while high
frequency component, that is in charge of picture details, is taken from a single image - the one that
presents good resolution for the area of interest while the camera view is aimost along the normal to
the reconstructed surface in that point.

Aver age - uses the weighted average value of all pixels from individual photos, the weight being
dependent on the same parametersthat are considered for high frequence component in mosaic mode.

Max | nt ensity - the photo which has maximum intensity of the corresponding pixel is selected.
M n | ntensity - the photo which has minimum intensity of the corresponding pixel is selected.

Di sabl ed - the photo to take the color value for the pixel from is chosen like the one for the high
frequency component in mosaic mode.

Texturesize/ count
Specifies the size (width & height) of the texture atlas in pixels and determines the number of files
for texture to be exported to. Exporting texture to severa files allows to archive greater resolution of
the final model texture, while export of high resolution texture to a single file can fail due to RAM
limitations.

Additionally the following advanced parameters can be adjusted.
Enable color correction
The feature is useful for processing of data sets with extreme brightness variation. However, please

notethat color correction processtakes up quite along time, so it isrecommended to enabl e the setting
only for the data sets that proved to present results of poor quality.

£ Note

* HDR texture generation requires HDR photos on input.

Improving texture quality

To improve resulting texture quality it may be reasonable to exclude poorly focused images from
processing at this step. PhotoScan suggests automatic image quality estimation feature. Imageswith quality
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value of less than 0.5 units are recommended to be disabled and thus excluded from texture generation

procedure. To disable a photo use w Disable button from the Photos pane toolbar.

PhotoScan estimates image quality as a relative sharpness of the photo with respect to other images in
the data set. The value of the parameter is calculated based on the sharpness level of the most focused
part of the picture.

To estimate image quality

1 Switch to the detailed view in the Photos pane using == Details command from the Change menu

on the Photos pane toolbar.
2. Select all photos to be analyzed on the Photos pane.

3. Right button click on the selected photo(s) and choose Estimate Image Quality command from the
context menu.

4. Once the analysis procedure is over, a figure indicating estimated image quality value will be
displayed in the Quality column on the Photos pane.

Building tiled model

Hierarchical tilesformat isagood solution for city scale modeling. It allowsfor responsive visualisation of
large area 3D modelsin high resolution, atiled model being opened with Agisoft Viewer - acomplementary
tool included in PhotoScan installer package.

Tiled model is build based on dense point cloud data. Hierarchical tiles are textured from the source
imagery.

4 Note

« Build Tiled Model procedure can be performed only for projects saved in .PSX format.

To build atiled model

1. Check the reconstruction volume bounding box - tiled model will be generated for the area within

bounding box only. To adjust the bounding box use the % Resize Region and 22’ Rotate Region
toolbar buttons. Rotate the bounding box and then drag corners of the box to the desired positions.

2. Select the Build Tiled Model... command from the Workflow menu.

3. Inthe Build Tiled model dialog box select the desired reconstruction parameters. Click OK button
when done.

4. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

Reconstruction parameters

Pixel size (m)
Suggested value shows automatically estimated pixel size due to input imagery effective resolution.
It can be set by the user in meters.
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Tilesize
Tile size can be set in pixels. For smaller tiles faster visualisation should be expected.

Building digital elevation model

PhotoScan allowsto generate and visualize adigital elevation model (DEM). A DEM represents a surface
model as aregular grid of height values. DEM can be rasterized from a dense point cloud, a sparse point
cloud or amesh. Most accurate results are cal culated based on dense point cloud data. PhotoScan enables
to perform DEM-based point, distance, area, volume measurements as well as generate cross-sections for
a part of the scene selected by the user. Additionally, contour lines can be calculated for the model and
depicted either over DEM or Orthomosai ¢ in Ortho view within PhotoScan environment. Moreinformation
on measurement functionality can be found in Performing measurements on DEM section.

4 Note

* Build DEM procedure can be performed only for projects saved in .PSX format.

« DEM can be calculated for referenced models only. So make sure that you have set a coordinate
system for your model before going to build DEM operation. For guidance on Setting coordinate
system please go to Setting coordinate system

DEM iscalculated for the part of the model within the bounding box. To adjust the bounding box use the

P Resize Region and 2?’ Rotate Region toolbar buttons. Rotate the bounding box and then drag corners
of the box to the desired positions.

To build DEM

1. Select the Build DEM... command from the Workflow menu.

2. IntheBuild DEM dialog box set Coordinate system for the DEM.
3. Select source datafor DEM rasterization.

4. Click OK button when done.

5. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

Parameters

Sour ce data
It is recommended to calculate DEM based on dense point cloud data. Preliminary elevation data
results can be generated from asparse point cloud, avoiding Build Dense Cloud step for timelimitation
reasons.

I nterpolation
If interpolation mode is Di sabl ed it leads to accurate reconstruction results since only areas
corresponding to dense point cloud points are reconstructed.

With Enabl ed (def aul t) interpolation mode PhotoScan will calculate DEM for all areas of the
scene that are visible on at least one image. Enabl ed (defaul t) setting is recommended for
DEM generation.
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In Ext r apol at ed mode the program generates holeless model with some elevation data being
extrapolated.

Point classes
The parameter alows to select a point class (classes) that will be used for DEM calcul ation.

To generate digital terrain model (DTM)), it is necessary to classify dense cloud points first in order to
divide them in at least two classes: ground points and the rest. Please refer to Classifying dense cloud
points section to read about dense point cloud classification options. Select Ground value for Point class
parameter in Build DEM dialog to generate DTM.

To calculate DEM for aparticular part of the project, use Region section of the Build DEM dialog. Indicate
coordinates of the bottom | eft and top right corners of the region to be exported in theleft and right columns
of the textboxes respectively. Suggested val uesindicate coordinates of the bottom left and top right corners
of the whole area to be rasterized, the area being defined with the bounding box.

Resolution value shows effective ground resolution for the DEM estimated for the source data. Size of the
resulting DEM, calculated with respect to the ground resolution, is presented in Total size textbox.

Building orthomosaic

Orthomosaic export isnormally used for generation of high resolution imagery based on the source photos
and reconstructed model. The most common application is aerial photographic survey data processing,
but it may be also useful when a detailed view of the object is required. PhotoScan enables to perform
orthomosaic seamline editing for better visual results (see Orthomosaic seamlines editing section of the
manual).

For multispectral imagery processing workflow Ortho view tab presents Raster Calculator tool for NDVI
and other vegetation indices cal culation to analyze crop problems and generate prescriptions for variable
rate farming equipment. More information on NDV I cal culation functionality can be found in Performing
measurements on mesh section.

£ Note

* Build Orthomosaic procedure can be performed only for projects saved in .PSX format.

To build Orthomosaic

1. Select the Build Orthomosaic... command from the Workflow menu.

2. Inthe Build Orthomosaic dialog box set Coordinate system for the Orthomosaic referencing.
3. Select type of surface data for orthorectified imagery to be projected onto.

4. Click OK button when done.

5. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

PhotoScan allows to project the orthomosaic onto a plane set by the user, providing that mesh is selected
as a surface type. To generate orthomosaic in a planar projection choose Planar Projection Type in
Build Orthomosaic dialog. Y ou can select projection plane and orientation of the orthomosaic. PhotoScan
provides an option to project the model to a plane determined by a set of markers (if there are no 3 markers
in a desired projection plane it can be specified with 2 vectors, i. e. 4 markers). Planar projection type
may be useful for orthomosaic generation in projects concerning facades or surfacesthat are not described
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with Z(X,Y) function. To generate an orthomosaic in planar projection, preliminary generation of mesh
dataisrequired.

Parameters

Surface
Orthomosaic creation based on DEM data is especially efficient for aerial survey data processing
scenarios alowing for time saving on mesh generation step. Alternatively, mesh surface type allows
to create orthomosaic for less common, yet quite demanded applications, like orthomaosaic generation
for facades of the buildings or other models that might be not referenced at all.

Blending mode
Mosai ¢ (defaul t) - implements approach with data division into several frequency domains
which are blended independently. The highest frequency component is blended aong the seamline
only, each further step away from the seamline resulting in a less number of domains being subject
to blending.
Aver age - usesthe weighted average value of all pixels from individual photos.
Di sabl ed - the color value for the pixel istaken from the photo with the camera view being almost
aong the normal to the reconstructed surface in that point.

Enable color correction
Color correction feature is useful for processing of data sets with extreme brightness variation.
However, please note that color correction process takes up quite along time, so it is recommended
to enabl e the setting only for the data sets that proved to present results of poor quality before.

Pixel size
Default value for pixel size in Export Orthomosaic dialog refers to ground sampling resolution, thus,
it is useless to set a smaller value: the number of pixels would increase, but the effective resolution
would not. However, if it is meaningful for the purpose, pixel size value can be changed by the user.

Max. dimension (pix)
The parameter allows to set maximal dimension for the resulting raster data.

PhotoScan generates orthomosaic for the whole area, where surface data is available. Bounding box
limitationsarenot applied. To build orthomosaic for aparticul ar (rectangular) part of the project use Region
section of the Build Orthomosaic dialog. I ndicate coordinates of the bottom left and top right corners of the
region to be exported in the left and right columns of the textboxes respectively. Estimate button allows
you to see the coordinates of the bottom left and top right corners of the whole area.

Estimate button enables to control total size of the resulting orthomosaic data for the currently selected
reconstruction area (all available data (default) or a certain region (Region parameter)) and resolution
(Pixel size or Max. dimension parameters). The information is shown in the Total size (pix) textbox.

Saving intermediate results

Certain stages of 3D model reconstruction can take a long time. The full chain of operations could
eventually last for 4-6 hours when building amodel from hundreds of photos. It is hot always possible to
complete al the operationsin one run. PhotoScan allows to save intermediate resultsin a project file.

PhotoScan Archive files (*.psz) may contain the following information:
« List of loaded photographs with reference paths to the image files.

 Photo alignment data such as information on camera positions, sparse point cloud model and set of
refined camera calibration parameters for each calibration group.

22



General workflow

» Masks applied to the photosin project.
» Depth maps for cameras.
* Dense point cloud model with information on points classification.

* Reconstructed 3D polygonal model with any changes made by user. This includes mesh and texture
if it was built.

 List of added markers aswell as of scale-bars and information on their positions.
* Structure of the project, i.e. number of chunksin the project and their content.

Notethat since PhotoScan tendsto generate extradense point cloudsand highly detailed polygona models,
project saving procedure can take up quite along time. Y ou can decrease compression level to speed up the
saving process. However, please note that it will result in alarger project file. Compression level setting
can be found on the Advanced tab of the Preferences dialog available from Tools menu.

The software also allows to save PhotoScan Project file (*.psx) which stores the links to the processing
resultsin *.psx file and the dataitself in * .files structured archive. Thisformat enables responsive loading
of large data (dense point clouds, meshes, etc.), thus avoiding delays on reopening a hundreds-of-photos
project. DEM and orthomosaic generation options are available only for projects saved in PSX format.

Y ou can save the project at the end of any processing stage and return to it later. To restart work simply
load the corresponding file into PhotoScan. Project files can also serve as backup files or be used to save
different versions of the same model.

Project files use relative paths to reference original photos. Thus, when moving or copying the project file
to another location do not forget to move or copy photographs with all the folder structure involved as
well. Otherwise, PhotoScan will fail to run any operation requiring source images, athough the project
file including the reconstructed model will be loaded up correctly. Alternatively, you can enable Store
absolute image paths option on the Advanced tab of the Preferences dialog available from Tools menu.

Exporting results

PhotoScan supports export of processing resultsin various representations; sparse and dense point clouds,
camera calibration and camera orientation data, mesh, etc. Orthomosaics and digital elevation models
(both DSM and DTM), as well as tiled models can be generated according to the user requirements.

Point cloud and camera calibration data can be exported right after photo alignment is completed. All other
export options are available after the corresponding processing step.

If you are going to export the results (point cloud / mesh / tiled model / orthomosaics) for the model that is
not referenced, please note that the resulting file will be oriented according to a default coordinate system
(see axesin the bottom right corner of the Model view), i. e. the model can be shown differently from what

[ 1Y
you see in PhotoScan window. To align the model orientation with the default coordinate system use “
Rotate object button from the Toolbar.

In some cases editing model geometry in the external software may be required. PhotoScan supports model
export for editing in external software and then allows to import it back as it is described in the Editing
model geometry section of the manual.

Main export commands are available from the File menu and the rest from the Export submenu of the
Tools menu.
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Point ¢

loud export

Toexport sparse or dense point cloud

1

2.

Select Export Points... command from the File menu.
Browse the destination folder, choose the file type, and print in the file name. Click Save button.
In the Export Points dialog box select desired Type of point cloud - Sparse or Dense.

Specify the coordinate system and indicate export parameters applicable to the selected file type,
including the dense cloud classes to be saved.

Click OK button to start export.

The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

Split in blocks option in the Export Points dialog can be useful for exporting large projects. It is available
for referenced models only. Y ou can indicate the size of the section in xy plane (in meters) for the point
cloud to be divided into respective rectangular blocks. The total volume of the 3D sceneis limited with
the Bounding Box. The whole volume will be split in equal blocks starting from the point with minimum
x and y values. Note that empty blocks will not be saved.

In

some casesit may be reasonableto edit point cloud before exporting it. To read about point cloud editing

refer to the Editing point cloud section of the manual.

PhotoScan supports point cloud export in the following formats:

£

Wavefront OBJ
Stanford PLY

XYZ text file format
ASPRSLAS

LAZ

ASTM E57

u3D

potree

Agisoft OC3
Topcon CL3

PDF

Note

» Saving color information of the point cloud is supported by the PLY, E57, LAS, LAZ, OC3,
CL3and TXT fileformats.

« Saving point normalsinformation is supported by the OBJ, PLY and TXT file formats.
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Tie points data export

To export matching points
1. Select Export Matches... command from the Tools menu.
2. Browsethe destination folder, choose the file type, and print in the file name. Click Save button.

3. Inthe Export Matches dialog box set export parameters. Precision value sets the limit to the number
of decimal digitsin thetie points coordinates to be saved.

4. Click OK bhutton to start export.

5. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

PhotoScan supports matching points data export in the following formats:

* BINGO (*.dat) - saves origina intrinsic and extrinsic camera data along with matching points
coordinates.

« ORIMA (*.txt)
« PATB (*.pth)

Matching points exported from PhotoScan can be used as a basis for AT procedure to be performed in
some external software. Later on, estimated camera data can be imported back to PhotoScan (using Import
Cameras command from the Tools menu) to proceed with 3D model reconstruction procedure.

Camera calibration and orientation data export

To export camera calibration and camera orientation data select Export Cameras... command from the
Tools menu.

PhotoScan supports camera data export in the following formats:
» Agisoft XML structure

» Bundler OUT file format

* CHAN fileformat

» Boujou TXT file format

» Omega Phi Kappatext file format

» PATB Exterior orientation

» BINGO Exterior orientation

» AeroSys Exterior orientation

* Inpho project file
£ Note

« Cameradata export in Bundler and Boujou file formats will save sparse point cloud datain the
samefile.
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» Cameradataexport in Bundler file format would not save distortion coefficients k3, k4.

To export / import only camera calibration data select Camera Calibration... command from the Tools

menu. Using ="/ Il?ll buttonsit is possible to load / save camera calibration datain the following formats:
» Agisoft Camera Calibration (*.xml)

e Australis Camera Parameters (*.txt)

» PhotoModeler Camera Calibration (*.ini)

» 3DM CalibCam Camera Parameters (*.txt)

e CaCam Camera Cdlibration (*.cal)

* Inpho Camera Calibration (*.txt)

Panorama export

PhotoScan is capable of panorama stitching for images taken from the same camera position - camera
station. To indicate for the software that loaded images have been taken from one camera station, one
should move those photos to a camera group and assign Camera Station type to it. For information on
camera groups refer to Loading photos section.

To export panorama
1. Select Export - Export Panorama... command from the Tools menu.
2. Select camera group which panorama should be previewed for.

3. Choose panoramaorientation in the file with the hel p of navigation buttonsto theright of the preview
window in the Export Panorama dial og.

4. Set exporting parameters: select camera groups which panorama should be exported for and indicate
export file name mask.

5. Click OK button
6. Browsethe destination folder and click Save button.

Additionally, you can set boundaries for the region of panoramato be exported using Setup boundaries
section of the Export Panorama dialog. Text boxes in the first line (X) allow to indicate the angle in the
horizontal plane and the second line (Y) serves for angle in the vertical plane limits. Image size option
enablesto control the size of the exporting file.

3D model export

To export 3D model
1. Select Export Model... command from the File menu.
2. Browsethe destination folder, choose the file type, and print in the file name. Click Save button.

3. Inthe Export Model dialog specify the coordinate system and indicate export parameters applicable
to the selected file type.
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4. Click OK bhutton to start export.

5. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

4 Note

* If the model is exported in local coordinates, PhotoScan can write a KML file for the exported
model to be correctly located on Google Earth.

If amodel generated with PhotoScan is to be imported in a 3D editor program for inspection or further
editing, it might be helpful to use Shift function while exporting the model. It allows to set the value to
be subtracted from the respective coordinate value for every vertex in the mesh. Essentialy, this means
trangl ation of themodel coordinate system origin, which may be useful since some 3D editors, for example,
truncate the coordinates values up to 8 or so digits, while in some projects they are decimals that make
sense with respect to model positioning task. So it can be recommended to subtract a value equa to the

whole part of acertain coordinate val ue (see Reference pane, Camera coordinates val ues) before exporting
the model, thus providing for areasonable scale for the model to be processed in a3D editor program.

PhotoScan supports model export in the following formats:

» Wavefront OBJ

» 3DSfileformat

* VRML

 COLLADA

o Stanford PLY

» STL models

» Autodesk FBX

» Autodesk DXF

» Google Earth KMZ

* U3D

» Adobe PDF

Somefileformats (OBJ, 3DS, VRML, COLLADA, PLY, FBX) save textureimage in aseparatefile. The
texture file should be kept in the same directory as the main file describing the geometry. If the texture
atlas was not built only the model geometry is exported.

PhotoScan supports direct uploading of the models to Sketchfab resource. To publish your model online
use Upload Model... command from the File menu.

Tiled model export

To export tiled model

1. Select Export Tiled Model... command from the File menu.

27



General workflow

2. Browsethe destination folder, choose the file type, and print in the file name. Click Save button.

3. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

PhotoScan supports tiled model export in the following formats:
e PhotoMesh Layer (*.zip)

e Agisoft Tiled Model (*.tls)

» Agisoft Tile Archive (*.zip)

Agisoft Tiled Model can be visualised in Agisoft Viewer application, which is included in Agisoft
PhotoScan Professional installation file. Thanks to hierarchical tiles format, it allows to responsively
visualise large models.

Orthomosaic export

To export Orthomosaic
1. Select Export Orthomosaic... command from the File menu.
2. Inthe Export Orthomosaic dialog box specify coordinate system for the Orthomosaic to be saved in.

3. Check Write KML file and / or Write World file options to create files needed to georeference the
orthomosaic in the Google Earthand / or aGIS.

4. Click Export button to start export.
5. Browse the destination folder, choose the file type, and print in the file name. Click Save button.

6. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

[{ Note

* Write KML file option is available only if the model is georeferenced in WGS84 coordinate
system due to the fact that Google Earth supports only this coordinate system.

« World file specifies coordinates of the four angle vertices of the exporting orthomosaic. This
information is already included in GeoTIFF file, however, you could duplicate it for some
reason. If you need to export orthomosaic in JPEG or PNG file formats and would like to have
georeferencing data this informations could be useful.

If the export file of afixed size is needed, it is possible to set the length of the longer side of the export
filein Max. dimension (pix) parameter. The length should be indicated in pixels.

Split in blocks option in the Export Orthomosaic dialog can be useful for exporting large projects. You
can indicate the size of the blocks (in pix) for the orthomosaic to be divided into. The whole areawill be
split in equal blocks starting from the point with minimum x and y values. Note that empty blocks will
not be saved.

To export a particular part of the project use Region section of the Export Orthomosaic dialog. Indicate
coordinates of the bottom | eft and top right corners of the region to be exported in theleft and right columns
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of the textboxes respectively. Estimate button allows you to see the coordinates of the bottom Ieft and top
right corners of the whole area.

Alternatively, you can indicate the region to be exported using polygon drawing option in the Ortho view
tab of the program window. (For instructions on polygon drawing refer to Shapes section of the manual.)
Once the polygon isdrawn, right-click on the polygon and set it as aboundary of the region to be exported
using Set Boundary Type option from the context menu.

Default value for pixel size in Export Orthomosaic dialog refers to ground sampling resolution, thus, it
is useless to set a smaller value: the number of pixels would increase, but the effective resolution would
not. If you have chosen to export orthomosaic with a certain pixel size (not using Max. dimension (pix)
option), it is recommended to check estimated Total size (pix) of the resulting file to be sure that it is not
too large to be correctly saved to the targeted file format.

For (Geo)TIFF export compression type may be set by the user. The following options are available:
LZW, JPEG, Packbits, Deflate. Additionally, the file may be saved without compression (None value
of the compression type parameter). Write BigTIFF file option allows to save files bigger than standard
TIFF limit of 4Gb. Total size textbox in the Export Orthomosaic dialog helps to estimate the size of the
resulting file. However, it is recommended to make sure that the application you are planning to open the
orthomosaic with supports BigTIFF format. Alternatively, you can split a large orthomosaic in blocks,
with each block fitting the limits of a standard TIFF file.

While exporting orthomosaic in JPEG format, JPEG quality parameter controls balance between
compression level (i.e. quality of the result) and export file size: the higher the value of the parameter (%)
the more emphasisis on the quality at the expense of alarger resulting file.

The following formats are supported for orthomaosaic export:
« JPEG

« PNG

« TIFF

* GeoTIFF

» Multiresolution Google Earth KML mosaic.

* Google Map Tiles.

* MBTiles.

* World Wind Tiles.

PhotoScan supports direct uploading of the orthomosaics to MapBox platform. To publish your
orthomosaic online use Upload Orthomosaic... command from the File menu.

4 Note

« MapBox upload requires secure token with upl oads: wri t e scopethat should be obtained on
the account page of the MapBox web-site. Secure token shouldn't be mixed up with the public
token, as the latter doesn't allow to upload orthomosaics from PhotoScan.

Multispectral orthomosaic export is supported in GeoTIFF format only. When exporting in other formats,
only master channel will be saved. Multispectral orthomosaic hasall channels of the original imagery plus
alpha channel, transparency being used for no-data areas of the orthomosaic.
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To export Multispectral orthomosaic

1. Select Export Orthomosaic... command from the File menu.

2. Follow steps 2-4 from Orthomosai c export procedure above.

3. Browsethe destination folder, choose GeoTIFF type, and print in the file name. Click Save button.

4. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

NDVI data export

Vegetation index data export is available with the Export Orthomosaic... command from the File menu.
V egetation index data can be saved as two types of data: asagrid of floating point index values calculated
per pixel of orthomosaic or as an orthomosaic in pseudocol ors according to a pallet set by user. The format
is controlled with Raster transform option in Export Orthomosaic / Export Google KMZ / Export Google
Map Tiles/ Export MBTiles/ Export World Wind Tiles dialogs. None value allows to export orthomosaic
generated for the data before any index calculation procedure was performed.

DEM (DSM/DTM) export

PhotoScan allows to calculate and then export both a digital surface model (DSM) and a digital terrain
model (DTM) (see Building digital elevation model section).

Toexport DEM
1. Select Export DEM... command from the File menu.
2. Inthe Export DEM dialog specify coordinate system to georeference the DEM.

3. Check Write KML file and/or Write World file options to create files needed to georeference the
DEM in the Google Earth and/or a GIS.

4. Click Export button to start export.
5. Browsethe destination folder, choose the file type, and print in the file name. Click Save button.

6. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

4 Note

* Write KML file option is available only if the model is georeferenced in WGS84 coordinate
system due to the fact that Google Earth supports only this coordinate system.

» Worldfilespecifiescoordinates of thefour angleverticesof theexporting DEM. Thisinformation
isalready included in GeoTIFF elevation dataaswell asin other supported file formatsfor DEM
export, however, you could duplicate it for some reason.

If export file of afixed sizeisneeded, it is possible to to set the length of the longer side of the export file
in Max. dimension (pix) parameter. The length should be indicated in pixels.

Unlike orthophoto export, it is sensible to set smaller pixel size compared to the default value in DEM
export dialog; the effective resolution will increase. If you have chosen to export DEM with a certain pixel
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size (not using Max. dimension (pix) option), it is recommended to check estimated Total size (pix) of the
resulting file to be sure that it is not too large to be correctly saved to the targeted file format.

No-data value is used for the points of the grid, where elevation value could not be calculated based on
the source data. Default value is suggested according to the industry standard, however it can be changed
by user.

Split in blocks option in the Export DEM dialog can be useful for exporting large projects or meeting
special DEM requirements. (See Orthomosaic export section for details.)

To export a particular part of the project use Region section of the Export DEM dialog. (See Orthomosaic
export section for details.) Similarly to orthomosaic export, polygons drawn over the DEM on the Ortho
tab of the program window can be set asboundariesfor DEM export. (For instructions on polygon drawing
refer to Shapes section of the manual.)

The following formats are supported for DEM export:

» GeoT|FF elevation data

Arc/Info ASCII Grid (ASC)

Band interleaved file format (BIL)

XYZ file format

Sputnik KMZ

Extra products to export

In addition to main targeted products PhotoScan allows to export several other processing results, like

» Undistort photos, i. e. photosfree of lensdistortions (Undistort Photos... command avail able from Export
submenu of the Tools menu).

» Depth map for any image (Export Depth... command available from photo context menu).

* Orthophotosfor individual images (Export Orthophotos... command available from Export submenu of
the Tools menu).

PhotoScan supports direct uploading of the models to Sketchfab resource and of the orthomosaics
to MapBox platform. To publish your model/orthomosaic online use Upload Model... and Upload
Orthomosaic... command from the File menu.

Processing report generation

PhotoScan supports automatic processing report generation in PDF format, which contains the basic
parameters of the project, processing results and accuracy evaluations.

To generate processing report
1. Select Generate Report... command from the File menu.
2. Browsethe destination folder, choose the file type, and print in the file name. Click Save button.

3. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.
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PhotoScan processing report presents the following data:
» Orthomosaic sketch.

» Survey data including coverage area, flying atitude, GSR, general camera(s) info, as well as overlap
statistics.

» Cameracalibration results: figures and an illustration for every sensor involved in the project.
» Camera positioning error estimates.

» Ground control points error estimates.

 Scale bars estimated distances and measurement errors.

* Digital elevation model sketch with resolution and point density info.

» Processing parameters used at every stage of the project.

4 Note

» Processing report can be exported after alignment step. Processing report export option is
available for georeferenced projects only.

Survey Data
Nunber of i mages - total number of images uploaded into the project.
Canera stations - number of aligned images.
Flyi ng al titude - average height above ground level.
Ti e poi nt s - total number of valid tie points (equals to the number of pointsin the sparse cloud).
G ound resol uti on - effective ground resolution averaged over al aligned images.
Pr oj ect i ons - total number of projections of valid tie points.
Cover age ar ea - size of the areathat has been surveyed.
Repr oj ecti on error -root mean sguare reprojection error averaged over all tie pointson all images.
Reprojection error is the distance between the point on the image where a reconstructed 3D point can be

projected and the original projection of that 3D point detected on the photo and used as a basis for the
3D point reconstruction procedure.

Camera Calibration

For precalibrated cameras internal parameters input by the user are shown on the report page. If acamera
was not precalibrated, internal camera parameters estimated by PhotoScan are presented.

Camera Locations
X error () -root mean square error for X coordinate for al the cameras.

Y error (n) -root mean square error for Y coordinate for all the cameras.
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XY error (m -root meansquareerror for X and Y coordinates for all the cameras.

Z error (m -root mean square error for Z coordinate for all the cameras.

Total error (m -root mean squareerror for X, Y, Z coordinates for all the cameras.
Total error = sart(Sumi=1" [(Xi, e - X, in)” + (Yi, est - Yi,in)” + (Zi, et - Zi,in)°] / 1)

Xi, in - input value for X coordinate for i camera position,

Xi. est - €stimated value for X coordinate for i camera position,

Yi,in - input value for Y coordinate for i camera position,

Yi et - €stimated value for Y coordinate for i camera position,

Z; in - input value for Z coordinate for i camera position,

Z; o - estimated value for Z coordinate for i camera position,

Ground Control Points
XY error (m -root mean squareerror for X and Y coordinates for a GCP location / check point.
Z error (n) -errorfor Z coordinate for a GCP location / check point.
Error (m -root mean square error for X, Y, Z coordinates for a GCP location / check point.
Pr oj ecti ons - number of projections for a GCP location / check point over al the images.

Error (pix) -root mean square error for X, Y coordinates on an image for a GCP location / check
point averaged over all theimages.

Tot al - impliesaveraging over al the GCP locations/ check points.

Scale Bars

Di stance (m - scalebar length estimated by PhotoScan.
Error (m - difference between input and estimated values for scale bar length.

Tot al - impliesaveraging over al the scale barsin Control/Check section.

Digital Elevation Model

Resol uti on - effective resolution of the exported DEM. The value depends on the Quality parameter
value used at Build point cloud step, providing that DEM has been generated from dense point cloud.

Poi nt Densi ty - average number of dense cloud points per square meter.

Processing Parameters

Processing report contains processing parameters information, which is also available form Chunk context
menu. Along with the values of the parameters used at various processing stages, this page of the report
presents information on processing time. Processing time attributed to Dense point cloud processing step
will exclude time spent on depth maps reconstruction, unless Keep depth maps option is checked on
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Advanced tab of Preferences dialog available from Tools menu. For projects calculated over network
processing time will not be shown.

PhotoScan matches images on different scales to improve robustness with blurred or difficult to match
images. The accuracy of tie point projections depends on the scale at which they were located. PhotoScan
uses information about scale to weight tie point reprojection errors. In the Reference pane settings dialog
tie point accuracy parameter now corresponds to normalized accuracy - i.e. accuracy of tie point detected
at the scale equal to 1. Tie points detected on other scales will have accuracy proportional to their scales.
This helps to obtain more accurate bundle adjustment results. On the processing parameters page of the
report (aswell asin chunk information dialog) two reprojection errors are provided: the reprojection error
in the units of tie point scale (this is the quantity that is minimized during bundle adjustment), and the
reprojection error in pixels (for convenience). The mean key point size value is a mean tie point scale
averaged across al projections.




Chapter 4. Referencing

Camera calibration

Calibration groups

While carrying out photo alignment PhotoScan estimates both internal and external camera orientation
parameters, including nonlinear radial distortions. For the estimation to be successful it is crucial to apply
the estimation procedure separately to photos taken with different cameras. Once photos have been loaded
in the program, PhotoScan automatically divides them into calibration groups according to the image
resolution and/or EXIF metadata like cameratype and focal length. All the actions described below could
and should be applied (or not applied) to each calibration group individually.

Calibration groups can be rearranged manually.

To createanew calibration group

1. Select Camera Calibration... command from the Tools menu.

2. Inthe Camera Cdlibration dialog box, select photos to be arranged in a new group.
3. Intheright-click context menu choose Create Group command.

4. A new group will be created and depicted on the |left-hand part of the Camera Calibration dial og box.

To move photos from one group to another
1. Select Camera Calibration... command from the Tools menu.
2. Inthe Camera Cdlibration dialog box choose the source group on the left-hand part of the dialog.

3. Select photos to be moved and drag them to the target group on the left-hand part of the Camera
Calibration dialog box.

To place each photo into a separate group you can use Split Groups command available at the right button
click on acalibration group name in the | eft-hand part of the Camera Calibration dialog

Cameratypes

PhotoScan supports four major types of camera: frame camera, fisheye camera, spherical camera and
cylindrical camera. Cameratype can be set in Camera Calibration dialog box available from Tools menu.

Fr ame camera. If the source data within a calibration group was shot with aframe camera, for successful
estimation of camera orientation parameters the information on approximate focal length (pix) isrequired.
Obviously, to calculate focal length valuein pixel it is enough to know focal length in mm along with the
sensor pixel sizein mm. Normally this data is extracted automatically from the EXIF metadata.

Frame camera with Fi sheye lens. If extra wide lenses were used to get the source data, standard
PhotoScan camera model will not allow to estimate camera parameters successfully. Fisheye cameratype
setting will initialize implementation of a different cameramodel to fit ultra-wide lens distortions.

Spheri cal camera (equirectangular projection). In case the source data within a calibration group
was shot with a spherical camera, camera type setting will be enough for the program to calculate
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camera orientation parameters. No additional information is required except the image in equirectangular
representation.

Spherical cameraCyl i ndri cal projection. In case the source data within a calibration group is a set
of panoramic images stitched according to cylindrical model, camera type setting will be enough for the
program to calculate camera orientation parameters. No additional information is required.

In case source images lack EXIF data or the EXIF datais insufficient to calculate focal length in pixels,
PhotoScan will assume that focal length equalsto 50 mm (35 mm film equivalent). However, if theinitial
guess values differ significantly from the actual focal length, it islikely to lead to failure of the alignment
process. So, if photosdo not contain EXIF metadata, it is preferableto specify focal length (mm) and sensor
pixel size (mm) manually. It can be done in Camera Calibration dialog box available from Tools menu.
Generally, this data is indicated in camera specification or can be received from some online source. To
indicate to the program that camera orientation parameters should be estimated based on the focal length
and pixel size information, it is necessary to set the Type parameter on the Initial tab to Auto value.

Camera calibration parameters

Once you have tried to run the estimation procedure and got poor results, you can improve them thanks
to the additional data on calibration parameters.

To specify camera calibration parameters
1. Select Camera Calibration... command from the Tools menu.

2. Select calibration group, which needs reestimation of camera orientation parameters on the left side
of the Camera Calibration dialog box.

In the Camera Calibration dialog box, select I ni ti al tab.

Modify the calibration parameters displayed in the corresponding edit boxes.
Set the Type to the Precalibrated value.

Repeat to every calibration group where applicable.

Click OK button to set the calibration.

Note

L ¥ @ o » w

o Alternatively, initia calibration data can be imported from file using Load button on the Initial
tab of the Camera Calibration dialog box. In addition to Agisoft calibration calibration file format
it ispossible to import data from Australis, PhotoModeler, 3DM CalibCam, CalCam.

Initial calibration data will be adjusted during the Align Photos processing step. Once Align Photos
processing step is finished adjusted calibration data will be displayed on the Adjusted tab of the Camera
Calibration dialog box.

If very precisecalibration dataisavailable, to protect it from recal culation one should check Fix calibration
box. In this case initial calibration datawill not be changed during Align Photos process.

Adjusted camera calibration data can be saved to file using Save button on the Adjusted tab of the Camera
Calibration dialog box.

Estimated camera distortions can be seen on the distortion plot available from context menu of a camera
group in the Camera Calibration dial og. In addition, residuals graph (the second tab of the same Distortion
Plot dialog) allows to evaluate how adequately the camera is described with the applied mathematical
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model. Note that residuals are averaged per cell of an image and then across al the images in a camera
group. Scale reference under the plot indicates the scale of the distortions/residuals.

Calibration parameters list

fx, fy
Focal length in x- and y-dimensions measured in pixels.

CX, cy
Principal point coordinates, i.e. coordinates of lens optical axis interception with sensor plane.

skew
Skew transformation coefficient.

k1, k2, k3, k4
Radia distortion coefficients.

p1, p2, p3, p4
Tangential distortion coefficients.

Setting coordinate system

Many applications require data with a defined coordinate system. Setting the coordinate system also
provides a correct scaling of the model allowing for surface area and volume measurements and makes
model loading in geoviewers and geoinformation software much easier. Some functionality like digital
elevation model export is available only after the coordinate system is defined.

PhotoScan supports setting a coordinate system based on either ground control point (marker) coordinates
or camera coordinates. In both cases the coordinates are specified in the Reference pane and can be either
loaded from the external file or typed in manually.

Setting coordinate system based on recorded camera positions is often used in aerial photography
processing. However it may be also useful for processing photos captured with GPS enabled cameras.
Placing markersisnot required if recorded camera coordinates are used to initialize the coordinate system.

In the case when ground control points are used to set up the coordinate system the markers should be
placed in the corresponding locations of the scene.

Using camera positioning data for georeferencing the model is faster since manual marker placement is
not required. On the other hand, ground control point coordinates are usually more accurate than telemetry
data, allowing for more precise georeferencing.

Placing markers

PhotoScan uses markers to specify locations within the scene. Markers are used for setting up a coordinate
system, photo alignment optimization, measuring distances and volumes within the scene as well as for
marker based chunk alignment. Marker positions are defined by their projections on the source photos.
The more photos are used to specify marker position the higher isaccuracy of marker placement. To define
marker location within a scene it should be placed on at least 2 photos.

4 Note

« Marker placement is not required for setting the coordinate system based on recorded camera
coordinates. This section can be safely skipped if the coordinate system is to be defined based
on recorded camera locations.
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PhotoScan supports two approaches to marker placement: manual marker placement and guided marker
placement. Manual approach implies that the marker projections should be indicated manually on each
photo where the marker is visible. Manual marker placement does not require 3D model and can be
performed even before photo alignment.

In the guided approach marker projection is specified for a single photo only. PhotoScan automatically
projects the corresponding ray onto the model surface and calculates marker projections on the rest of
the photos where marker is visible. Marker projections defined automatically on individual photos can be
further refined manually. Reconstructed 3D model surface is required for the guided approach.

Guided marker placement usually speeds up the procedure of marker placement significantly and also
reduces the chance of incorrect marker placement. It is recommended in most cases unless there are any
specific reasons preventing this operation.

To place amarker using guided approach
1. Open aphoto where the marker is visible by double clicking on its name.

2 Switch to the marker editing mode using ”Q? Edit Markers toolbar button.

3. Right click on the photo at the point corresponding to the marker location.

4. Select Create Marker command from the context menu. New marker will be created and itsprojections
on the other photos will be automatically defined.

4 Note

« |If the 3D model is not available or the ray at the selected point does not intersect with the model
surface, the marker projection will be defined on the current photo only.

 Guided marker placement can be performed in the same way from the 3D view by right clicking

on the corresponding point on the model surface and using ":B Create Marker command from the
context menu. While the accuracy of marker placement in the 3D view isusually much lower, it
may be still useful for quickly locating the photos observing the specified location on the model.

To view the corresponding photos use Hﬂ Filter by Markers command again from the 3D view
context menu. If thecommand isinactive, please make surethat the marker in question is selected
on the Reference pane.

To placeamarker using manual approach

1 Create marker instance using “%Add marker button on the Workspace pane or by Add Marker

command from the Chunk context menu (available by right clicking on the chunk title on the
Workspace pane).

2. Openthe photo where the marker projection needsto be added by doubl e clicking on the photos name.

Switch to the marker editing mode using ”Q? Edit Markers toolbar button.

4. Right click at the point on the photo where the marker projection needsto be placed. From the context
menu open Place Marker submenu and select the marker instance previously created. The marker
projection will be added to the current photo.

5. Repeat the previous step to place marker projections on other photos if needed.
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To save up time on manual marker placement procedure PhotoScan offers guiding lines feature. When a
marker is placed on an aligned photo, PhotoScan highlights lines, which the marker is expected to lie on,
on the rest of the aligned photos.

4 Note

e If a marker has been placed on at least two aligned images PhotoScan will find the marker

projections on the rest of the photos. The calculated marker positions will be indicated with 3‘
icon on the corresponding aligned photos in Photo View mode.

Automatically defined marker locations can be |ater refined manually by dragging their projections on the
corresponding photos.

Torefinemarker location

1. Open the photo where the marker is visible by double clicking on the photo's name. Automatically

placed marker will be indicated with % con,

Switch to the marker editing mode using ”Q? Edit Markers toolbar button.

3. Movethe marker projection to the desired location by dragging it using left mouse button. Once the

marker location is refined by user, the marker icon will change to ”'—‘U

4 Note

» To list photos where the marker locations are defined, select the corresponding marker on the
Workspace pane. The photos where the marker is placed will be marked with a"ﬂ? icon on the

Photos pane. To filter photos by marker use H@ Filter by Markers command from the 3D view
context menu.

In those cases when there are hesitations about the features depicted on the photo, comparative inspection
of two photos can prove to be useful. To open two photos in PhotoScan window simultaneously Move to
Other Tab Group command is available from photo tab header context menu.

To open two photos simultaneously

1. Inthe Photos pane double click on one photo to be opened. The photo will be opened in a new tab
of the main program window.

2. Right click on thetab header and choose Moveto Other Tab Group command from the context menu.
The main program window will be divided into two parts and the photo will be moved to the second
part.

3. Thenext photo you will choose to be opened with a double click will be visualized in the active tab
group.

PhotoScan automatically assignsdefault |abelsfor each newly created marker. Theselabel s can be changed
using the Rename... command from the marker context menu in the Workspace / Reference pane.

Assigning reference coordinates

To reference the model the real world coordinates of at least 3 points of the scene should be
specified. Depending on the requirements, the model can be referenced using marker coordinates, camera
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coordinates, or both. Real world coordinates used for referencing the model along with the type of
coordinate system used are specified using the Reference pane.

The model can be located in either local Euclidean coordinates or in georeferenced coordinates. For
model georeferencing awide range of various geographic and projected coordinate systems are supported,
including widely used WGS84 coordinate system. Besides, amost al coordinate systems from the EPSG
registry are supported aswell.

Reference coordinates can be specified in one of the following ways:
» Loaded from a separate text file (using character separated values format).
» Entered manually in the Reference pane.

 Loaded from GPS EXIF tags (if present).

Toload reference coordinates from a text file

1 Click = Import toolbar button on the Reference pane. (To open Reference pane use Reference

command from the View menu.) Browse to the file containing recorded reference coordinates and
click Open button.

2. IntheImport CSV dialog set the coordinate system if the data presents geographical coordinates.

3. Sdlect thedelimiter and indicate the number of the datacolumn for each coordinate. | ndicate columns
for the orientation data if present.

4. Click OK button. The reference coordinates data will be loaded onto the Reference pane.

4 Note

* Inthe datafile columns and rows are numbered starting from O.

« If reference coordinates of amarker / camera position for aphoto are not specified in the loading
file the current value will be kept for them.

* Anexample of acoordinates datafilein the CSV format is given in the next section.

Information on the accuracy of the source coordinates(X, y, z) can beloaded withaCSV fileaswell. Check
Load Accuracy option and indicate the number of the column where the accuracy for the data should be
read from. The same figure will be tackled as accuracy information for al three coordinates.

To assign reference coor dinates manually

1 Switch to the View Source mode using E View Source button from the Reference pane toolbar. (To

open Reference pane use Reference command from the View menu.)
2. On the Reference pane double click on x/y/z cellsto assign values to corresponding coordinates.
3.  Repeat for every marker / camera position needed to be specified.

4. Toremove unnecessary reference coordinates select corresponding items from the list and press Del
key.

Click '_“JIIE Update toolbar button to apply changes and set coordinates.
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Additionally, it is possible to indicate accuracy data for the coordinates. Select Set Accuracy... command
from the context menu of an image on the Reference pane and input accuracy data both for position (i.e.
X,Yy,Z coordinates) and orientation (i.e. yaw, pitch, roll angles) data. It is possible to select several cameras
and apply Set Accuracy... command simultaneousely to all of them. Alternatively, you can select Accuracy
(m) or Accuracy (deg) text box for a certain camera on the Reference pane and press F2 button on the
keyboard to type the text data directly onto the Reference pane. Note that "/* delimeter allows to enter
different accuracy datafor x, y, z or yaw, pitch, roll data respectively.

Toload reference coordinates from GPS EXIF tags

Click E Import EXIF button on the Reference pane. (To open Reference pane use Reference
command from the View menu.) The reference coordinates data will be loaded into the Reference
pane.

After reference coordinates have been assigned PhotoScan automatically estimates coordinatesin alocal
Euclidean system and calculates the referencing errors. To see the results switch to the View Estimated

or View Errors modes respectively using @ View Estimated and L_l_ View Errors toolbar buttons. The
largest error will be highlighted.

To set a georeferenced coordinate system
1. Assign reference coordinates using one of the options described above.

2 Click % satti ngs button on the Reference pane toolbar.

3. In the Reference Settings dialog box select the Coordinate System used to compile reference
coordinates data if it has not been set at the previous step.

4. Specify the assumed measurement accuracy.

5. Indicate relative camera to GPS system coordinates if present in Camera Correction section of the
Reference Settings dialog box.

6. Click OK button to initialize the coordinate system and estimate geographic coordinates.

Rotation angles in PhotoScan are defined around the following axes: yaw axis runs from top to bottom,
pitch axis runs from left to right wing of the drone, roll axis runs from tail to nose of the drone. Zero
values of the rotation angle triple define the following camera position aboard: camera looks down to the
ground, frames are taken in landscape orientation, and horizontal axis of the frame is perpendicular to the
central (tail-nose) axis of the drone. If the camerais fixed in a different position, respective yaw, pitch,
roll values should beinput in the camera correction section of the Settings dialog. The senses of the angles
are defined according to the right-hand rule.

[ Note

e Step 5 can be safely skipped if you are using standard GPS system (not that of superhigh
precision).

In Select Coordinate System dialog it is possible to ease searching for the required georeferencing system
using Filter option. Enter respective EPSG code (e.g. EPSG::4302) to filter the systems.

To view the estimated geographic coordinates and reference errors switch between the View Estimated

and View Errors modes respectively using @ View Estimated and L_l_ View Errorstoolbar buttons. The

41



Referencing

largest error will be highlighted. A click on the column name on the Reference pane sorts the markers and
photos by the data in the column. At this point you can review the errors and decide whether additional
refinement of marker locations is required (in case of marker based referencing), or if certain reference
points should be excluded.

To savethe errorsand / or estimated coordinates use Export toolbar button on the Reference pane.

To reset a chunk georeferencing use Reset Transform command from the chunk context menu on the
Workspace pane. [R] indicator of achunk being georeferenced will be removed from the chunk name.

[{ Note

» Unchecked reference points on the Reference pane are not used for georeferencing. Use context
menu to check / uncheck selected items.

« After adjusting marker locations on the photos, the coordinate system will not be updated

automatically. It should be updated manually using 'TIE Update toolbar button on the Reference
pane.

» PhotoScan allows to convert the estimated geographic coordinates into a different coordinate
system. To calculate the coordinates of the camera positions and / or markers in a different

coordinate system use || Convert toolbar button on the Reference pane.

Example of areference coordinates file in CSV format
(*.txt)

Thereference coordinates can be loaded onto the Reference pane using character separated text fileformat.
Each reference point isspecifiedin thisfile on aseparateline. Samplereference coordinatesfileisprovided
bel ow:

# <l abel > <> <y> <z>

I MG_0159. JPG 40. 165011 48.103654 433. 549477
I MG_0160. JPG 40. 165551 48.103654 434.724281
I MG_0161. JPG 40. 166096 48.103640 435. 630558

Individual entries on each line should be separated with at ab (space, semni col on, comma, etc)
character. All lines starting with # character are treated as comments.

Records from the coordinate file are matched to the corresponding photos or markers basing on the
| abel field. Camera coordinates |abels should match the file name of the corresponding photo including
extension. Marker coordinates |abels should match the labels of the corresponding markersin the project
file. All labels are case insensitive.

£ Note

e Character separated reference coordinates format does not include specification of the type of
coordinate system used. The kind of coordinate system used should be selected separately.

« PhotoScan requires z value to indicate height above the ellipsoid.
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Using different vertical datums

On default PhotoScan requires all the source atitude values for both cameras and markers to be input as
values mesuared above the ellipsoid. However, PhotoScan allowsfor the different geoid model s utilization
as well. PhotoScan installation package includes only EGM 96 geoid model, but additional geoid models
can be downloaded from Agisoft's website if they are required by the coordinate system selected in
the Reference pane settings dialog; alternatively, a geoid model can be loaded from a custom PRJ file.
Downloaded geoid model from the supported list should be copied to \ geoi ds\ folder in PhotoScan
installation directory before using the corresponding coordinate system from GUI.

Please refer to the following web-page to review the list of supported geoid models: http:/
www.agisoft.com/downloads/geoids/.

Optimization

Optimization of camera alignment

PhotoScan estimates internal and external camera orientation parameters during photo alignment. This
estimation is performed using image data alone, and there may be some errorsin the final estimates. The
accuracy of the final estimates depends on many factors, like overlap between the neighboring photos, as
well as on the shape of the object surface. These errors can lead to non-linear deformations of the final
model.

During georeferencing the model is linearly transformed using 7 parameter similarity transformation (3
parameters for trandation, 3 for rotation and 1 for scaling). Such transformation can compensate only a
linear model misalignment. The non-linear component can not be removed with this approach. This is
usually the main reason for georeferencing errors.

Possible non-linear deformations of the model can be removed by optimizing the estimated point cloud
and camera parameters based on the known reference coordinates. During this optimization PhotoScan
adjusts estimated point coordinates and camera parameters minimizing the sum of reprojection error and
reference coordinate misalignment error.

To achieve greater optimizing results it may be useful to edit sparse point cloud deleting obviously
mislocated points beforehand. To read about point cloud editing refer to the Editing point cloud section
of the manual.

Georeferencing accuracy can be improved significantly after optimization. It is recommended to perform
optimization if the final model is to be used for any kind of measurements.

To optimize camera alignment
1. Set the marker and/or camera coordinates to be used for optimization (if not done yet).

2 Click @ Setti ngstoolbar button on the Reference pane and set the coordinate system (if not doneyet).

3. Inthe Reference pane Settings dialog box specify the assumed accuracy of measured values as well
as the assumed accuracy of marker projections on the source photos.

4. Click OK button.

5. Indicate relative GPS device and/or INS to camera coordinates (if info is available) on GPS/INS tab
of Camera Calibration dialog available from Tools menu.
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6. Check Fix GPS/INS offset box.

7. Click OK button.

Click # Optimize toolbar button. In Optimize Camera Alignment dialog box check additional
camera parameters to be optimized if needed. Click OK button to start optimization.

9. After the optimization is complete, the georeferencing errors will be updated.

4 Note

« Step 5 can be safely skipped if you are using standard GPS (not that of extremely high precision).

« Tangentia distortion parameters p3, p4, are available for optimization only if pl, p2 values are
not equal to zero after alignment step.

« The model data (if any) is cleared by the optimization procedure. You will have to rebuild the
model geometry after optimization.

Image coordinates accuracy for markers indicates how precisely the markers were placed by the user or
adjusted by the user after being automatically placed by the program.

Ground altitude parameter is used to make reference preselection mode of alignment procedure work
effectively for oblique imagery. See Aligning photos for details.

Camera, marker and scale bar accuracy can be set per item (i.d. per camera/marker/scale bar) using
Accuracy column on the Reference pane. Accuracy values can be typed in on the pane per item or for a
group of selected items. Alternatively accuracy values can be uploaded along with camera/lmarker data
as atext file (see Assigning reference coordinates subsection of Setting coordinate system). Additionally,
different accuraciesper coordinate can beindicated using"/" asaseparator between valuesin the Accuracy
column.

GPS/INS offset values input by the user can also be adjusted by PhotoScan with respect to measurement
accuracy that may beindicated on the GPS/INS tab of Camera Calibration dialog. Uncheck Fix GPS/INS
offset box to allow for adjustment procedure.

Generally it isreasonableto run optimization procedure based on markersdataonly. It isdueto thefact that
GCPs coordinates are measured with significantly higher accuracy compared to GPS data that indicates
camera positions. Thus, markers data are sure to give more precise optimization results. Moreover, quite
often GCP and camera coordinates are measured in different coordinate systems, that also prevents from
using both cameras and markers data in optimization simultaneously.

The results of the optimization procedure can be evaluated with the help of error information on the
Reference pane. In addition, distortion plot can be inspected along with mean residuals visualised per
calibration group. Thisdatais available from Camera Calibration dialog (Tools menu), from context menu
of a camera group - Distortion Plot... command. Note that residuals are averaged per cell of an image
and then across all the images in a camera group. Scale reference under the plot indicates the scale of the
distortiong/residuals.

In case optimization results does not seem to be satisfactory, you can try recalculating with lower values
of parameters, i.e. assuming ground control measurements to be more accurate.

Scale bar based optimization

Scale bar is program representation of any known distance within the scene. It can be a standard ruler or
a specialy prepared bar of a known length. Scale bar is a handy tool to add supportive reference data to
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your project. They can prove to be useful when there is no way to locate ground control points all over
the scene. Scale bars alow to save field work time, since it is significantly easier to place several scae
bars with precisely known length, then to measure coordinates of afew markers using special equipment.
In addition, PhotoScan allows to place scale bar instances between cameras, thus making it possible to
avoid not only marker but ruler placement within the scene as well. Surely, scale bar based information
will not be enough to set a coordinate system, however, the information can be successfully used while
optimizing the results of photo alignment. It will also be enough to perform measurements in PhotoScan
software. See Performing measurements on mesh.

To add a scale bar

1. Placemarkersat the start and end points of the bar. For information on marker placement please refer
to the Setting coordinate system section of the manual.

2. Select both markers on the Reference pane using Ctrl button.

Select B Create Scale Bar command form the Model view context menu. The scale bar will be
created and an instant added to the Scale Bar list on the Reference pane.

Switch to the E View Source mode using the Reference pane toolbar button.

5. Double click on the Distance (m) box next to the newly created scale bar name and enter the known
length of the bar in meters.

To add a scale bar between camer as

1. Select the two cameras on the Workspace or Reference pane using Ctrl button. Alternatively, the
cameras can be selected in the Model view window using selecting tools from the Toolbar.

Select E& Create Scale Bar command form the context menu. The scale bar will be created and an
instant added to the Scale Bar list on the Reference pane.

Switch to the E View Source mode using the Reference pane toolbar button.

4. Doubleclick on the Distance (m) box next to the newly created scale bar name and enter the known
length of the bar in meters.

Torun scale bar based optimization

1. Onthe Reference pane check all scale barsto be used in optimization procedure.

2 Click &% Setti ngs toolbar button on the Reference pane. In the Reference pane Settings dialog box

specify the assumed accuracy of scale bars measurements.

3. Click OK button.

Click # Optimize toolbar button. In Optimize Camera Alignment dialog box check additional
camera parameters to be optimized if needed. Click OK button to start optimization.

After the optimization is complete, cameras and markers estimated coordinates will be updated as well as
al the georeferencing errors. To analyze optimization results switch to the View Estimated mode using
the Reference pane toolbar button. In scale bar section of the Reference pane estimated scale bar distance
will be displayed.
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To delete a scale bar
1. Select the scale bar to be deleted on the Reference pane.
2. Right-click on it and chose Remove Scale Bars command from the context menu.

3. Click OK for the selected scale bar to be deleted.

What do the errors in the Reference pane mean?

Cameras section
1. Error (m) - distance between the input (source) and estimated positions of the camera.
2. Error (deg) - root mean square error calculated over all three orientation angles.

3. Error (pix) - root mean square reprojection error calculated over al feature points detected on the
photo.

Reprojection error is the distance between the point on the image where a reconstructed 3D point can be
projected and the original projection of that 3D point detected on the photo and used as a basis for the
3D point reconstruction procedure.

Markers section
1. Error (M) - distance between the input (source) and estimated positions of the marker.

2. Error (pix) - root mean sguare reprojection error for the marker calculated over al photos where
marker isvisible.

Scale Bar s section

»  Error (M) - difference between the input (source) scale bar length and the measured distance between
two cameras or markers representing start and end points of the scale bar.

If the total reprojection error for some marker seems to be too large, it is recommended to inspect
reprojection errors for the marker on individual photos. The information is available with Show Info
command from the marker context menu on the Reference pane.

Working with coded and non-coded targets

Overview

Coded and non-coded targets are specially prepared, yet quite ssimple, real world markers that can add up
to successful 3D model reconstruction of a scene. The difference between coded and non-coded targets
is that while a non-coded target looks like an ordinary full circle or afigure (circle / rectangular) with 4
segments, the coded target has aring parted in black and white segments around the central full circle.

Coded targets advantages and limitations

Coded targets (CTs) can be used as markersto define local coordinate system and scal e of the model or as
true matches to improve photo alignment procedure. PhotoScan functionality includes automatic detection
and matching of CTson source photos, which allowsto benefit from marker implementation in the project
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while saving time on manual marker placement. Moreover, automatic CTs detection and marker placement
is more precise then manual marker placement.

PhotoScan supports three types of circle CTs: 12 bit, 16 bit and 20 bit. While 12 bit pattern is considered
to be decoded more precisely, 16 bit and 20 bit patterns allow for a greater number of CTs to be used
within the same project.

To be detected successfully CTs must take up a significant number of pixels on the original photos. This
leadsto anatural limitation of CTsimplementation: while they generally proveto be useful in close-range
imagery projects, aerial photography projects will demand too huge CTsto be placed on the ground, for
the CTsto be detected correctly.

Coded targets in workflow

Sets of all patterns of CTs supported by PhotoScan can be generated by the program itself.

To createa printable PDF with coded targets

1. Select Print Markers... command from the Tools menu.

2. Specify the CTstype and desired print parametersin Print Markers dialog.
3. Click OK.

Once generated, the pattern set can be printed and the CTs can be placed over the scene to be shot and
reconstructed.

When the images with CTs seen on them are uploaded to the program, PhotoScan can detect and match
the CTs automatically.

To detect coded targets on sour ce images

1. Select Detect Markers... command from the Tools menu.

2. Specify parameters of detector in Detect Markers dialog according to the CTstype.

3. Click OK.

PhotoScan will detect and match CTs and add corresponding markers to the Reference pane.

CTs generated with PhotoScan software contain even number of sectors. However, previous versions of
PhotoScan software had no restriction of the kind. Thus, if the project to be processed contains CTs from
previousversions of PhotoScan software, it isrequired to disable parity check in order to make the detector
work.

Non-coded targets implementation

Non-coded targets can al so be automatically detected by PhotoScan (see Detect Markersdialog) . However,
for non-coded targets to be matched automatically, it is necessary to run align photos procedure first.

Non-coded targets are more appropriate for aerial surveying projects due to the simplicity of the pattern
to be printed on a large scale. But, looking alike, they does not allow for automatic identification, so
manual assignment of an identifier is required if some referencing coordinates are to be imported from
afile correctly.
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Performing measurements on mesh

PhotoScan supports measuring of distances between control points, aswell as of surface areaand volume
of the reconstructed 3D model.

Distance measurement

PhotoScan enabl es measurements of direct distances between the points of the reconstructed 3D scene. The
points used for distance measurement must be defined by placing markers in the corresponding locations.
Model coordinate system must be also initialized before the distance measurements can be performed.
Alternatively, the model can be scaled based on known distance (scal e bar) information to become suitable
for measurements.

For instructions on placing markers, refining their positions and setting coordinate system please refer to
the Setting coordinate system section of the manual. Scale bar concept is described in the Optimization
section.

To measure distance

1. Placethe markersin the scene at the locations to be used for distance measurement. For information
on marker placement please refer to the Setting coordinate system section of the manual.

2. Select both markersto be used for distance measurements on the Reference pane using Ctrl button.

Select £ Create Scale Bar command form the 3D view context menu. The scale bar will be created
and an instant added to the Scale Bar list on the Reference pane.

Switch to the estimated values mode using @ View Estimated button from the Reference pane
toolbar.

5. The estimated distance for the newly created scale bar equals to the distance that should have been
measured.

To measur e distance between camer as

1. Select the two cameras on the Workspace or Reference pane using Ctrl button. Alternatively, the
cameras can be selected in the Model view window using selecting tools from the Toolbar.

Select B Create Scale Bar command form the context menu. The scale bar will be created and an
instant added to the Scale Bar list on the Reference pane.

Switch to the estimated values mode using @ View Estimated button from the Reference pane
toolbar.

4. The estimated distance for the newly created scale bar equals to the distance that should have been
measured.

4 Note

* Please note that the scale bar used for distance measurements must be unchecked on the
Reference pane.
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4 Note

e The distance values measured by PhotoScan are displayed in meters.

Surface area and volume measurement

Surface area or volume measurements of the reconstructed 3D model can be performed only after the scale
or coordinate system of the scene is defined. For instructions on setting coordinate system please refer to
the Setting coordinate system section of the manual.

To measur e surface area and volume
1. Select Measure Areaand Volume... command from the Tools menu.

2. Thewhole model surface areaand volume will be displayed in the Measure Areaand VVolume dialog
box. Surface area is measured in square meters, while mesh volume is measured in cubic meters.

V olume measurement can be performed only for the models with closed geometry. If there are any holes
in the model surface PhotoScan will report zero volume. Existing holes in the mesh surface can be filled
in before performing volume measurements using Close Holes... command from the Tools menu.

Performing measurements on DEM

PhotoScan is capable of DEM-based point, distance, area, and volume measurements as well as of
generating cross-sections for a part of the scene selected by the user. Additionally, contour lines can be
calculated for the model and depicted either over DEM or Orthomosaic in Ortho view within PhotoScan
environment. Measurements on the DEM are controlled with shapes: points, polylines and polygons.

Shapes

Shapes are used to indicate boundaries either for DEM/Orthomosaic export or for the measurement
procedures. Shapes can be drawn over DEM or Orthomosaic using buttons from the Ortho view toolbar.
Alternatively, shapes can be loaded from a .SHP file using Import Shapes... subcommand of Import...
command available from the Tools menu. Shapes created in PhotoScan can be exported using Export
Shapes... subcommand of Export... command available from the Tools menu

Todraw ashape

1. Open DEM/orthomosaic in Ortho view double clicking on DEM/orthomosaic label in the Workspace
pane.

Select “?" Draw Point/* ™ Draw Polyline/'_ Draw Polygon instrument from the Ortho view tool bar.
3. Draw apoint/polyline/polygon on the DEM/orthomosaic with a cursor.

4. Doubleclick on thelast point to indicate the end of a polyline. To complete a polygon, place the end
point over the starting one.

> Oncethe shapeisdrawn, ashape label ' will be added to the chunk data structure on the Workspace
pane. All shapes drawn on the same DEM (and on the corresponding orthomosaic) will be shown
under the same label on the Workspace pane.

6. The program will switch to a navigation mode once a shape is compl eted.
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After a shape has been drawn, it can be edited using Insert Vertex / Delete Vertex commands from the
context menu. Delete V ertex command is active only for avertex context menu. To get accessto the vertex
context menu, select the shape with a double click first, and then select the vertex with adouble click on
it. To change position of avertex, drag and drop it to a selected position with the cursor.

Point measurement

Ortho view allows to measure coordinates of any point on the reconstructed model. X and Y coordinates
of the point indicated with the cursor as well as height of the point above the vertical datum selected by
the user are shown in the bottom right corner of the Ortho view.

Distance measurement

To measure distance

1 Connect the points of interest with a polyline using A Draw Polyline tool from the Ortho view

tool bar.
2. Double click on the last point to indicate the end of a polyline.
3. Right button click on the polyline and select Measure... command from the context menu.

4. Inthe Measure Shape dialog inspect the results. Perimeter value equals to the distance that should
have been measured.

In addition to polyline length value (see perimeter value in the Measure Shape), coordinates of the vertices
of the polyline are shown on the Planar tab of the Measure Shape dialog.

4  Note

< Measure option is available from the context menu of a selected polyline. To select a polyline,
double-click on it. A selected polylineis coloured in red.

Surface area and volume measurement

To measure area and volume

1 Draw apolygon on the DEM using _/Draw Polygon instrument to indicate the area to be measured.

2. Right button click on the polygon and select Measure... command from the context menu.

3. Inthe Measure Shape dialog inspect the results: see area value on the Planar tab and volume values
on the Volume tab.

PhotoScan allows to measure volume above best fit / mean level / custom level planes. Best fit and mean
level planes are calculated based on the drawn polygon vertices. VVolume measured against custom level
plane allows to trace volume changes for the same area in the course of time.

£ Note

« Measure option is available from the context menu of a selected polygon. To select a polygon,
double-click on it. A selected polygon is coloured in red.
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Cross sections and contour lines

PhotoScan enables to calculate cross sections, using shapes to indicate the plane(s) for a cut(s), the cut
being made with aplane parallel to Z axis. For apolyline/polygon the program will calculate profilesalong
all the edges starting from the first drawn side.

To calculate cross section

1 , . A L e
Indicate aline to make a cut of the model using” * Draw Polyline/'—' Draw Polygon tool from the
Ortho view toolbar.

2. Doubleclick on thelast point to indicate the end of apolyline.

3. Right button click on the polyline/polygon and select Measure... command from the context menu.

4. Inthe Measure Shape dialog inspect the results on the Profile tab of the dialog.

Generate Contours...command is available either from DEM label context menu on the Workspace pane
or from the Tools menu.

To gener ate contours
1. Select Generate Contours...command from Tools menu.
2. Inthe Generate Contours dialog select DEM as the source data for calculation.

3. Setvauesfor Minimal atitude, Maximal altitude parameters as well asthe Interval for the contours.
All the values shoud! be indicated in meters.

4. Click OK button once done.

5. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

6. When the procedureisfinished, a contour lines label will be added to the project file structure shown
on the Workspace pane.

Contour lines can be shown over the DEM or orthomosaic on the Ortho tab of the program window. Use

‘S show contour linestool from the Ortho tab toolbal to switch the function on and off. Contour lines can
be deleted using Remove Contours command from the contour lineslabel context menu on the Workspace
pane.

Contour lines can be exported using Export Contours command from the contour lineslabel context menu
on the Workspace pane. Alternatively the command is available from the Tools menu. In the Export
Contour Linesdialog it is necessary to select the type of the contour lines to be exported. A .SHP file can
store the lines of the same type only: either polygons or polylines.

Vegetation indices calculation

PhotoScan enables to calculate NDVI and other vegetation indices based on the multispectral imagery
input. A vegetation index formulacan be set by the user, thus allowing for great flexibility in dataanalysis.
Calculated data can be exported asagrid of floating point index values calculated per pixel of orthomosaic
or as an orthomosaic in pseudocolors according to a pallet set by the user.
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To calculate a vegetation index

1. Open orthomosaic in the Ortho tab doubleclicking on the orthomosaic label on the Workspace pane.

2 Open Raster Calculator tool using ¥ Raster Calculator button from the Ortho view toolbar.

3. Input an index expression using keyboard input and operators buttons of the raster calculator if
necessary.

4. Check Enable transform box and press OK button to calculate index values.

5. Once the operation is completed, the result will be shown in the Ortho view, index values being
visualised with colours according to the palette set in the Raster Calculator dialog.

Palette defines the colour for each index value to be shown with. PhotoScan offers several standard pal ette
presets on the Palette tab of the Raster Calculator dialog. A preset (NDVI, Heat, Gray scal€) can be chosen
from adrop-down list. Alternatively, the user can upload the palette from a Surfer Color Spectrum (*.clr)

file (Y Import Palette), preliminary prepared in an external tool. The palette can also be edited within

PhotoScan environment using L::'Add Color and @ Remove Color buttons on the Pal ette tab of the Raster
Calculator dialog. For each new line added to the palette a certain index value should be typed in. Double
click on the newly added line to type the value in. A customised palette can be saved for future projects

using HExport Pal ette button on the Palette tab of the Raster Calculator dialog.

PhotoScan enables to calculate contour lines based on the calculated index values.

To calculate contour lines based on vegetation index data

1. Select Generate Contours... command from the orthomosaic icon context menu on the Workspace
pane, while index data is shown in the Ortho view.

2. Select Orthomosaic as the source for the contours calculation.
3. Adjust the min/max value and the interval parameters for the task.
4. PressOK button to calculate index values.

5. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

6. When the procedureisfinished, a contour lines label will be added to the project file structure shown
on the Workspace pane. The contour lines will be shown over the index data on the Ortho tab.

[ Note

« PhotoScan keeps only the latest contour lines data calculated. Thus, if you need to save contour
lines calculated for the DEM data, use Export Contours... command from the contour lines |abel
context menu on the Workspace pane before generating contour lines for the index data.

After vegetation index results having been inspected, the origina orthomosaic can be opened with
unchecking Enable transform box in the Raster Calculator and pressing OK button.

Index data can be saved with Export orthomosaic command from the File menu. For guidance on the export
procedure, please refer to NDVI data export section of the manual.
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Using masks

Overview

5|

Masks are used in PhotoScan to specify the areas on the photos which can otherwise be confusing to
the program or lead to incorrect reconstruction results. Masks can be applied at the following stages of
processing:

» Alignment of the photos

* Building dense point cloud
* Building 3D model texture
» Exporting Orthomosaic

Alignment of the photos
Masked areas can be excluded during feature point detection. Thus, the objects on the masked parts
of the photos are not taken into account while estimating camera positions. This is important in the
setups, where the object of interest is not static with respect to the scene, like when using aturn table
to capture the photos.

Masking may be also useful when the object of interest occupies only a small part of the photo. In
this case a small number of useful matches can be filtered out mistakenly as a noise among a much
greater number of matches between background objects.

Building dense point cloud
While building dense point cloud, masked areas are not used in the depth maps computation process.
Masking can be used to reduce the resulting dense cloud complexity, by eliminating the areas on the
photos that are not of interest.

Masked areas are always excluded from processing during dense point cloud and texture generation
stages.

Let'stake for instance a set of photos of some object. Along with an object itself on each photo some
background areas are present. These areas may be useful for more precise camera positioning, so it
is better to use them while aligning the photos. However, impact of these areas at the building dense
point cloud is exactly opposite: the resulting model will contain object of interest and its background.
Background geometry will "consume" some part of mesh polygons that could be otherwise used for
modeling the main object.

53



Editing

Setting the masks for such background areas allows to avoid this problem and increases the precision
and quality of geometry reconstruction.

Building texture atlas
During texture atlas generation, masked areas on the photos are not used for texturing. Masking areas

on the photos that are occluded by outliers or obstacles helps to prevent the "ghosting” effect on the
resulting texture atlas.

Loading masks

Masks can be loaded from external sources, as well as generated automatically from background images
if such datais available. PhotoScan supports loading masks from the following sources:

» From alphachannel of the source photos.
» From separate images.
» Generated from background photos based on background differencing technique.

» Based on reconstructed 3D model.

Toimport masks
1. Select Import Masks... command from the Tools menu.
2. Inthe Import Mask dialog select suitable parameters. Click OK button when done.

3. When generating masks from separate or background images, the folder selection dialog will appear.
Browse to the folder containing corresponding images and select it.

4. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

The following parameters can be specified during mask import:
Import masksfor
Specifies whether masks should be imported for the currently opened photo, active chunk or entire
Workspace.
Current phot o - load mask for the currently opened photo (if any).
Active chunk - load masksfor active chunk.

Entire wor kspace - load masksfor al chunksin the project.

Method
Specifies the source of the mask data.

From Al pha - load masks from alpha channel of the source photos.
From Fi | e - load masks from separate images.
Fr om Backgr ound - generate masks from background photos.

From Model - generate masks based on reconstructed model.
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Mask file names (not used in Fr om al pha mode)

Specifies the file name template used to generate mask file names. This template can contain special
tokens, that will be substituted by corresponding data for each photo being processed. The following
tokens are supported:

{fil ename} - filename of the source photo without extension.
{fileext} -extension of the source photo.

{caner a} - cameralabel.

{frame} - frame number.

{filenunt -sequential number of the mask being imported.

For example, {filename} _mask.png template can be used if masks are available in PNG format and
havea_mask suffix.

Tolerance (Fr om Backgr ound method only)

Specifies the tolerance threshold used for background differencing. Tolerance value should be set
according to the color separation between foreground and background pixels. For larger separation
higher tolerance values can be used.

Editing masks

Modification of the current mask is performed by adding or subtracting selections. A selection is created
with one of the supported sel ection tools and is not incorporated in the current mask until it is merged with
amask using Add Selection or Subtract Selection operations.

To edit the mask

1

Open the photo to be masked by double clicking on its name on the Workspace / Photo pane. The
photo will be opened in the main window. The existing mask will be displayed as a shaded region
on the photo.

Select the desired selection tool and generate a selection.

'Invert Selection button allowsto invert current
selection prior to adding or subtracting it from the mask.

Selection to subtract the selection from the mask.

The following tools can be used for creating selections:

r—1

L_1 Rectangle selection tool

Rectangle selection tool is used to select large areas or to clean up the mask after other selection tools
were applied.

% Intelligent scissorstool

Intelligent scissorsis used to generate a selection by specifying its boundary. The boundary isformed
by selecting a sequence of vertices with a mouse, which are automatically connected with segments.
The segments can be formed either by straight lines, or by curved contours snapped to the object
boundaries. To enable snapping, hold Ctrl key while selecting the next vertex. To complete the
selection, the boundary should be closed by clicking on the first boundary vertex.

55



Editing

% ntelligent paint tool
Intelligent paint tool is used to "paint" a selection by the mouse, continuously adding small image
regions, bounded by object boundaries.

M agic wand tool
Magic Wand tool is used to select uniform areas of the image. To make a selection with a Magic
Wand tool, click inside the region to be selected.

The range of pixel colors selected by Magic Wand is controlled by the tolerance value. At lower
tolerance values the tool selectsfewer colors similar to the pixel you click with the Magic Wand tool.
Higher value broadens the range of colors selected.

4 Note

« Toadd new areato the current selection hold the Ctrl key during selection of additional area.
» Toreset mask selection on the current photo press Esc key.

A mask can be inverted using Invert Mask command from the Photo menu. The command is active in
Photo View only. Alternatively, you can invert masks either for selected cameras or for all camerasin a
chunk using Invert Masks... command from a photo context menu on the Photos pane.

The masks are generated individually for each image. If some object should be masked out, it should be
masked out on all photos, where that object appears.

Saving masks
Created masks can be also saved for external editing or storage.

To export masks

1. Select Export Masks... command from the Tools menu.

2. Inthe Export Mask dialog select suitable parameters. Click OK button when done.
3. Browseto the folder where the masks should be saved and select it.

4. The progress dialog box will appear displaying the current processing status. To cancel processing
click Cancel button.

The following parameters can be specified during mask export:

Export masksfor
Specifies whether masks should be exported for the currently opened photo, active chunk or entire
Workspace.

Current phot o - save mask for the currently opened photo (if any).
Act i ve chunk - save masks for active chunk.
Entire workspace - save masksfor al chunksin the project.

Filetype
Specifies the type of generated files.
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Si ngl e channel mask i mage - generates single channel black and white mask images.

I mage wi th al pha channel - generatescolor imagesfrom source photos combined with mask
datain alpha channel.

Mask file names
Specifies the file name template used to generate mask file names. This template can contain special
tokens, that will be substituted by corresponding data for each photo being processed. The following
tokens are supported:
{fil enane} - filename of the source photo without extension.
{fil eext} -extension of the source photo.
{caner a} - cameralabel.
{frame} - frame number.

{filenun} -sequential number of the mask being exported.

For example, { filename} _mask.png template can be used to export masksin PNG format with _nmask
suffix.

4 Note

« When importing/exporting mask for the current photo only, PhotoScan will prompt for the actual
image instead of image folder. Mask file names parameter will not be used in this case.

Editing point cloud

The following point cloud editing tools are available in PhotoScan:
» Automatic filtering based on specified criterion (sparse cloud only)

» Automatic filtering based on applied masks (dense cloud only)

Automatic filtering based on points colours (dense cloud only)
» Reducing number of pointsin cloud by setting tie point per photo limit (sparse cloud only)

» Manual points removal

[{ Note

« Point cloud editing operation can be undone/redone using Undo/Redo command from the Edit
menu.

Filtering points based on specified criterion

In some cases it may be useful to find out where the points with high reprojection error are located within
the sparse cloud, or remove points representing high amount of noise. Point cloud filtering helps to select
such points, which usually are supposed to be removed.

PhotoScan supports the following criteriafor point cloud filtering:
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Reprojection error
High reprojection error usualy indicates poor localization accuracy of the corresponding point
projections at the point matching step. It is also typical for false matches. Removing such points can
improve accuracy of the subsequent optimization step.

Reconstruction uncertainty
High reconstruction uncertainty is typical for points, reconstructed from nearby photos with small
baseline. Such points can noticeably deviate from the object surface, introducing noise in the point
cloud. While removal of such points should not affect the accuracy of optimization, it may be useful
to remove them before building geometry in Point Cloud mode or for better visual appearance of the
point cloud.

Image count
PhotoScan reconstruct all the points that are visible at least on two photos. However, points that are
visible only on two photos are likely to be located with poor accuracy. Image count filtering enables
to remove such unreliable points from the cloud.

Projection Accuracy
Thiscriterion allowsto filter out points which projectionswere relatively poorer localised dueto their
bigger size.

Toremove points based on specified criterion

1 Switch to Point Cloud view mode using 28 Point Cloud toolbar button.

2. Select Gradual Selection... command from the Edit menu.

3. Inthe Gradua Selection dialog box specify the criterion to be used for filtering. Adjust the threshold
level using the dlider. You can observe how the selection changes while dragging the slider. Click
OK buitton to finalize the selection.

To remove selected points use Delete Selection command from the Edit menu or click X Delete
Selection toolbar button (or simply press Del button on the keyboard).

Filtering points based on applied masks

Toremove points based on applied masks

1 Switch to Dense Cloud view mode using =5 Dense Cloud toolbar button.

2. Choose Select Masked Points... command from the Dense Cloud submenu of the Tools menu.

3. Inthe Select Masked Points dialog box indicate the photos whose masks to be taken into account.
Adjust the edge softness level using the dlider. Click OK button to run the selection procedure.

To remove selected points use Delete Selection command from the Edit menu or click Pt Delete
Selection toolbar button (or simply press Del button on the keyboard).

Filtering points based on points colors
Toremove points based on points colors

Switch to Dense Cloud view mode using Dense Cloud toolbar button.
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2. Choose Select Points by Color... command from the Dense Cloud submenu of the Tools menu.

3. Inthe Select Points by Color dialog box the color to be used as the criterion. Adjust the tolerance
level using the slider. Click OK button to run the selection procedure.

To remove selected points use Delete Selection command from the Edit menu or click X Delete
Selection toolbar button (or simply press Del button on the keyboard).

Tie point per photo limit

Tiepoint limit parameter could be adjusted before Align photos procedure. The number indicatesthe upper
limit for matching points for every image. Using zero value doesn't apply any tie-point filtering.

The number of tie points can a so be reduced after the alignment processwith Tie Points- Thin Point Cloud
command available from Tools menu. As a results sparse point cloud will be thinned, yet the alignment
will be kept unchanged.

Manual points removal

Incorrect points can be also removed manually.

Toremove pointsfrom a point cloud manually

1 Switch to Sparse Cloud view mode using 28 Point Cloud toolbar button or to Dense Cloud view
mode using Dense Cloud toolbar button.

2 Select points to be removed using L -1 Rectangle Selection, (22 Circle Selection or % Free-Form
Selection tools. To add new points to the current selection hold the Ctrl key during selection of
additional points. To remove some points from the current selection hold the Shift key during
selection of pointsto be removed.

3.

To delete selected points click the X Delete Selection toolbar button or select Delete Selection

command from the Edit menu. To crop selection to the selected points click the -Ef- Crop Selection
toolbar button or select Crop Selection command from the Edit menu.

Classifying dense cloud points

PhotoScan allows not only to generate and visualize dense point cloud but also to classify the pointswithin
it. There are two options: automatic division of all the pointsinto two classes - ground points and the rest,
and manual selection of agroup of points to be placed in a certain class from the standard list known for
LIDAR data. Dense cloud points classification opens way to customize Build Mesh step: you can choose
what type of objects within the scene you would like to be reconstructed and indicate the corresponding
point class as a source data for mesh generation. For example, if you build mesh or DEM based on ground
points only, it will be possible to export DTM (as opposed to DSM) at the next step.

Automatic classification of ground points

For the user to avoid extramanual work PhotoScan offersfeature for automatic detection of ground points.
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To classify ground points automatically
1. Select Classify Ground Points... command from the Dense Cloud submenu of the Tools menu.

2. IntheClassify Ground Points dialog box select the source point data for the classification procedure.
Click OK button to run the classification procedure.

Automatic classification procedure consists of two steps. At the first step the dense cloud is divided into
cellsof acertain size. In each cell the lowest point is detected. Triangulation of these points gives the first
approximation of the terrain model.

At the second step new point is added to the ground class, providing that it satisfies two conditions: it lies
within a certain distance from the terrain model and that the angle between terrain model and the line to
connect this new point with a point from a ground class is less than a certain angle. The second step is
repeated while there still are points to be checked.

The following parameters control automatic ground points classification procedure

Max angle (deg)
Determines one of the conditionsto be checked whiletesting apoint asaground one, i.e. setslimitation
for an angle between terrain model and the line to connect the point in question with a point from a
ground class. For nearly flat terrain it isrecommended to use default value of 15 deg for the parameter.
It isreasonable to set a higher value, if the terrain contains steep slopes.

Max distance (m)
Determinesoneof the conditionsto be checked whiletesting apoint asaground one, i.e. setslimitation
for a distance between the point in question and terrain model. In fact, this parameter determines the
assumption for the maximum variation of the ground elevation at atime.

Cell size(m)
Determines the size of the cells for point cloud to be divided into as a preparatory step in ground
points classification procedure. Cell size should be indicated with respect to the size of the largest
area within the scene that does not contain any ground points, e. g. building or close forest.

Manual classification of dense cloud points

PhotoScan allows to associate all the points within the dense cloud with a certain standard class (see
LIDAR data classification). This provides possibility to diversify export of the processing results with
respect to different types of objects within the scene, e. g. DTM for ground, mesh for buildings and point
cloud for vegetation.

Toassign aclassto a group of points

1 Switch to Dense Cloud view mode using using Dense Cloud toolbar button.

2. . . LT Ty .
Select points to be placed to a certain class using .- Rectangle Selection, -+ Circle Selection or

-;_ﬂ Free-Form Selection tools. To add new points to the current selection hold the Ctrl key during
selection of additional points. To remove some points from the current selection hold the Shift key
during selection of points to be removed.

3. Sdect Assign Class... command from the Dense Cloud submenu of the Tools menu.

4. Inthe Assign Class dialog box select the source point data for the classification procedure and the
targeted class to be assigned to the selected points. Click OK button to run classification procedure.
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Dense point cloud classification can be reset with Reset Classification command from Tools - Dense Cloud
menu.

Editing model geometry

The following mesh editing tools are available in PhotoScan:
» Decimation tool

» Close Holestool

» Automatic filtering based on specified criterion

» Manual polygon removal

* Fixing mesh topology

More complex editing can be done in the external 3D editing tools. PhotoScan allows to export mesh and
then import it back for this purpose.

4 Note

 For polygon removal operations such as manual removal and connected component filtering it
is possible to undo the last mesh editing operation. There are Undo/Redo commands in the Edit
menul.

 Please note that undo/redo commands are not supported for mesh decimation and this operation
cannot be undone.

Decimation tool

Decimation is atool used to decrease the geometric resolution of the model by replacing high resolution
mesh with a lower resolution one, which is still capable of representing the object geometry with high
accuracy. PhotoScan tendsto produce 3D model s with excessive geometry resolution, so mesh decimation
isusually a desirable step after geometry computation.

Highly detailed models may contain hundreds of thousands polygons. While it is acceptable to work with
such acomplex modelsin 3D editor tools, in most conventional tools like Adobe Reader or Google Earth
high complexity of 3D models may noticeably decrease application performance. High complexity also
results in longer time required to build texture and to export model in pdf file format.

In some casesit isdesirable to keep as much geometry details as possiblelikeit is needed for scientific and
archive purposes. However, if there are no special requirementsit is recommended to decimate the model
down to 100 000 - 200 000 polygons for exporting in PDF, and to 100 000 or even less for displaying in
Google Earth and alike tools.

To decimate 3D model
1. Select Decimate Mesh... command from the Tools menu.

2. Inthe Decimate Mesh dialog box specify the target number of polygons, which should remain in the
final model. Click on the OK button to start decimation.

3. The progress dialog box will appear displaying the current processing status. To cancel processing
click on the Cancel button.
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4 Note

e Textureatlasisdiscarded during decimation process. Y ou will have to rebuild texture atlas after
decimation is complete.

Close Holes tool

Close Holes tool provides possibility to repair your model if the reconstruction procedure resulted in a
mesh with several holes, due to insufficient image overlap for example.

Some tasks require a continuous surface disregarding the fact of information shortage. It is necessary to
generate a close model, for instance, to fulfill volume measurement task with PhotoScan.

Close holes tool enables to close void areas on the model substituting photogrammetric reconstruction
with extrapolation data. It is possible to control an acceptable level of accuracy indicating the maximum
size of aholeto be covered with extrapolated data.

To close holesin a 3D model
1. Sedlect Close Holes... command from the Tools menu.

2. Inthe Close Holes dia og box indicate the maximum size of ahole to be covered with the slider. Click
on the OK button to start the procedure.

3. The progress dialog box will appear displaying the current processing status. To cancel processing
click on the Cancel button.

[{ Note

* Thedlider alowsto set the size of ahole in relation to the size of the whole model surface.

Polygon filtering on specified criterion

In some cases reconstructed geometry may contain the cloud of small isolated mesh fragments surrounding
the "main" model or big unwanted polygons. Mesh filtering based on different criteria helps to select
polygons, which usually are supposed to be removed.

PhotoScan supports the following criteria for face filtering:

Connected component size
This filtering criteria allows to select isolated fragments with a certain number of polygons. The
number of polygonsin all isolated components to be selected is set with a dider and is indicated in
relation to the number of polygons in the whole model. The components are ranged in size, so that
the selection proceeds from the smallest component to the largest one.

Polygon size
This filtering criteria allows to select polygons up to a certain size. The size of the polygons to be
selected is set with adider and isindicated in relation to the size of the whole model. This function
can be useful, for example, in case the geometry was reconstructed in Smooth type and thereis aneed
to remove extra polygons automatically added by PhotoScan to fill the gaps; these polygons are often
of alarger size that the rest.

Toremove small isolated mesh fragments

1. Select Gradual Selection... command from the Edit menu.
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In the Gradual Selection dialog box select Connected component size criterion.

Select the size of isolated components to be removed using the dider. You can observe how the
selection changes while dragging the slider. Click OK button to finalize the selection.

To remove the selected components use Delete Selection command from the Edit menu or click X
Delete Selection toolbar button (or simply press Del button on the keyboard).

Toremovelarge polygons

1

2.

Select Gradual Selection... command from the Edit menu.
In the Gradual Selection dialog box select Polygon size criterion.

Select the size of polygonsto beremoved using theslider. Y ou can observe how the selection changes
while dragging the slider. Click OK button to finalize the selection.

To remove the selected components use Delete Selection command from the Edit menu or click X
Delete Selection toolbar button (or simply press Del button on the keyboard).

Note that PhotoScan always selects the fragments starting from the smallest ones. If the model contains
only one component the selection will be empty.

Manual face removal

Unnecessary and excessive sections of model geometry can be also removed manually.

Toremove part of the mesh polygons manually

1.

-1

Select rectangle, circle or free-form selection tool using . - . Rectangle Selection, {_? Circle Selection

or 'l_g Free-Form Selection toolbar buttons.

Make the selection using the mouse. To add new polygons to the current selection hold the Ctrl key
during selection of additional polygons. To remove some polygons from the current selection hold
the Shift key during selection of polygons to be excluded.

To delete selected polygons click the X Delete Selection toolbar button or use Delete Selection

command from the Edit menu. To crop sel ection to the selected polygonsclick the tlf- Crop Selection
toolbar button or use Crop Selection command from the Edit menu.

Togrow or shrink current selection

1.

To grow current selection press PageUp key in the selection mode. To grow selection by even alarger
amount, press PageUp while holding Shift key pressed.

To shrink current selection press PageDown key in the selection mode. To shrink selection by even
alarger amount, press PageDown while holding Shift key pressed.

Fixing mesh topology

PhotoScan is capable of basic mesh topology fixing.
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To fix mesh topology
1. Select View Mesh Statistics... command from the Tools menu.

2. In the Mesh Statistics dialog box you can inspect mesh parameters. If there are any topological
problems, Fix Topology button will be active and can be clicked to solve the problems.

3. The progress dialog box will appear displaying the current processing status. To cancel processing
click on the Cancel button.

Editing mesh in the external program

To export mesh for editing in the external program
1. Select Export Model... command from the File menu.

2. Inthe Save Asdialog box, specify the desired mesh format in the Save as type combo box. Select the
file name to be used for the model and click Save button.

3. Inthe opened dialog box specify additional parameters specific to the selected file format. Click OK
button when done.

Toimport edited mesh
1. Select Import Mesh... command from the Tools menu.

2. Inthe Open diaog box, browse to the file with the edited model and click Open.

4 Note

 PhotoScan supports loading models in Wavefront OBJ, 3DS, STL, COLLADA, Stanford PLY,
Autodesk FBX, Autodesk DXF, OpenCTM and U3D fileformatsonly. Please make sureto select
one of these file formats when exporting model from the external 3D editor.

» Please be aware that it isimportant to keep reference information for the model if any.

Orthomosaic seamlines editing

PhotoScan software offers various blending options at orthomosaic generation step for the user to adjust
processing to their data and task. However, in some projects moving objects can cause artifacts which
interfere with visual quality of the orthomosaic. The same problem may result from oblique aerial imagery
processing if the area of interest contains high buildings or if the user has captured facade from too oblique
positions. To eliminate mentioned artifacts PhotoScan offers seamline editing tool. The functionality
allowsto choose manually the image or imagesto texture the indicated part of the orthomosaic from. Thus,
the final orthomosaic can be improved visualy according to the user's expectations.

Automatic seamlines can be turned on for inspection in the Ortho view with pressing the 1 Show
Seamlines button from the Ortho view toolbar.

To edit orthomosaic seamlines

Draw a polygon on the orthomosaic using " Draw Polygon instrument to indicate the area to be
retextured.
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2. Select Assign Images... command from the context menu of the selected polygon.

3. In the Assign Images dialog box select the image to texture the area inside the polygon from.
Orthomosai ¢ preview on the Ortho tab allowsto evaluate the results of the selection. Click OK button
to finalise the image selection process.

Click ﬁ‘:rl'ﬂ Update Orthomosai ¢ button from the Ortho view toolbar to apply the changes.

Assign Images dialog allows to activate multiple selection option. If the Allow multiple selection option
ischecked, it is possible to assign several images to texture the areainside the polygon from. However, in

this case there is no possibility to preview the resulting orthomosaic. It is necessary to Click I_*',:fﬂ Update
Orthomosai ¢ button from the Ortho view toolbar to apply the changes and seetheresults. Until the changes
are applied, the area of interest will be marked with a net of blue colour to indicate that some edits are
waiting for enforcement. Blending method selected at build orthomosaic step will be implemented at
orthomosaic editing step.

Assign Images dialog, alternatively, allows to exclude selected images from texturing the area of interest.
Check Exclude selected images option to follow thisway. Please note that in this case preview illustrates
theimageto be excluded, i.d. the results one should expect after applying the changes are not shown. Click

[y Update Orthomosai ¢ button from the Ortho view toolbar to apply the changes
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Using chunks

When working with typical datasets, automation of general processing workflow allowsto perform routine
operations efficiently. PhotoScan allows to assign several processing steps to be run one by one without
user intervention thanks to Batch Processing feature. Manual user intervention can be minimized even
further dueto 'multiple chunk project’ concept, each chunk to include onetypical dataset. For aproject with
several chunks of the same nature, common operations available in Batch Processing dialog are applied to
each selected chunk individually, thus allowing to set several data setsfor automatic processing following
predefined workflow pattern.

In addition, multiple chunk project could be useful when it turns out to be hard or even impossible to
generate a 3D model of the whole scene in one go. This could happen, for instance, if the total amount
of photographs is too large to be processed at a time. To overcome this difficulty PhotoScan offers a
possibility to split the set of photos into several separate chunks within the same project. Alignment of
photos, building dense point cloud, building mesh, and forming texture atlas operations can be performed
for each chunk separately and then resulting 3D models can be combined together.

Working with chunks is not more difficult than using PhotoScan following the genera workflow. In fact,
in PhotoScan always exists at |east one active chunk and all the 3D model processing workflow operations
are applied to this chunk.

To work with several chunks you need to know how to create chunks and how to combine resulting 3D
models from separate chunks into one model.

Creating a chunk

To create new chunk click on the -2 Add Chunk toolbar button on the Workspace pane or select Add
Chunk command from the Workspace context menu (available by right-clicking on the root element on
the Workspace pane).

After the chunk is created you may load photosinit, align them, generate dense point cloud, generate mesh
surface model, build texture atlas, export the models at any stage and so on. The models in the chunks
are not linked with each other.

The list of all the chunks created in the current project is displayed in the Workspace pane along with
flags reflecting their status.

The following flags can appear next to the chunk name:

R (Referenced)
Notifies that 3D model in the chunk was referenced. Also will appear when two or more chunks are
aligned with each other. See information on how to reference the model in Setting coordinate system.

S (Scaled)
Notifiesthat 3D model inthe chunk was scal ed based on scale barsinformation only, with no reference
coordinates data being present. See information on scale bar placement in Optimization section.

To move photos from one chunk to another simply select them in thelist of photos on the Workspace pane,
and then drag and drop to the target chunk.
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Working with chunks

All operations within the chunk are carried out following the common workflow: loading photographs,
aligning them, generating dense point cloud, building mesh, building texture atlas, exporting 3D model
and so on.

Note that all these operations are applied to the active chunk. When anew chunk is created it is activated
automatically. Save project operation savesthe content of all chunks. To save selected chunks as aseparate
project use Save Chunks command from the chunk context menu.

To set another chunk as active
1. Right-click on the chunk title on the Workspace pane.

2.  Select Set Active command from the context menu.

Toremove chunk
1. Right-click on the chunk title on the Workspace pane.

2. Select Remove Chunks command from the context menu.

Aligning chunks

After the "partial” 3D models are built in several chunks they can be merged together. Before merging
chunks they need to be aligned.

To align separate chunks
1. Select Align Chunks command from the Workflow menu.

2. Inthe Align Chunks dialog box select chunks to be aligned, indicate reference chunk with a double-
click. Set desired alignment options. Click OK button when done.

3. The progress dialog box will appear displaying the current processing status. To cancel processing
click the Cancel button.

Aligning chunks parameters

Thefollowing parameters control the chunksalignment procedure and can be modified inthe Align Chunks
dialog box:

Method
Defines the chunks alignment method. Poi nt  based method aligns chunks by matching photos
across all the chunks. Mar ker based method uses markers as common points for different chunks.
Thedetails on using markers are avail able in the Setting coordinate system section. Caner a based
method is used to align chunks based on estimated camera locations. Corresponding cameras should
have the same label.

Accuracy (Point based alignment only)
Higher accuracy setting hel psto obtain more accurate chunk alignment results. L ower accuracy setting
can be used to get the rough chunk alignment in the shorter time.

Point limit (Point based alignment only)
The number indicates upper limit of feature points on every image to be taken into account during
Poi nt based chunks alignment.
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Fix scale
Option is to be enabled in case the scales of the models in different chunks were set precisely and
should be left unchanged during chunks alignment process.

Preselect image pairs (Point based alignment only)
The alignment process of many chunks may take a long time. A significant portion of this time is
spent for matching of detected features across the photos. Image pair preselection option can speed
up this process by selection of a subset of image pairs to be matched.

Constrain features by mask (Point based alignment only)
When this option is enabled, features detected in the masked image regions are discarded. For
additional information on the usage of masks refer to the Using masks section.

[ Note

¢ Chunk alignment can be performed only for chunks containing aligned photos.

« Thereis no need to perform chunk alignment for georeferenced chunks, as they are already in
the same coordinate frame.

Merging chunks
After aignment is complete the separate chunks can be merged into a single chunk.

To merge chunks
1. Select Merge Chunks command from the Workflow menu.

2. Inthe Merge Chunks dialog box select chunks to be merged and the desired merging options. Click
OK button when done.

3. PhotoScan will mergethe separate chunksinto one. The merged chunk will be displayed in the project
content list on Workspace pane.

Thefollowing parameters control the chunks merging procedure and can be modified in the Merge Chunks
dialog box:

Mer ge dense clouds
Defines if dense clouds from the selected chunks are combined.

Merge models
Defines if models from the selected chunks are combined.

Merge markers
Defines if markers from the selected chunks are merged (only markers with the same labels would
be merged).

Chunks merging result (i.e. photos, point clouds and geometry) will be stored in the new chunk and it may
be treated as an ordinary chunk (e.g. the model can be textured and/or exported).

Batch processing

PhotoScan allows to perform general workflow operations with multiple chunks automatically. It isuseful
when dealing with alarge number of chunks to be processed.
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Batch processing can be applied to al chunks in the Workspace, to unprocessed chunks only, or to the
chunks selected by the user. Each operation chosen in the Batch processing dialog will be applied to every
selected chunk before processing will move on to the next step.

Align Photos Align/Merge Chunks Save/load Project
Optimize Alignment Reset Region Export/Import Cameras
Build Dense Cloud Decimate Mesh Export Points

Build Mesh Close Holes Export Model

Build Texture Import Masks Export Texture

Build Tiled Model Classify Ground Points Export Model Tiles
Build DEM Import Shapes Export DEM

Build Orthomosaic Generate Report Export Orthomosaic

To start batch processing
1. Select Batch Process... command from the Workflow menu.
2. Click Add to add the desired processing stages.

3. Inthe Add Job dialog select the kind of operation to be performed, the list of chunks it should be
applied to, and desired processing parameters. Click OK button when done.

4. Repeat the previous steps to add other processing steps as required.
5. Arrange jobs by clicking Up and Down arrows at the right of the Batch Process... dialog box.
6. Click OK button to start processing.

7. Theprogress dialog box will appear displaying the list and status of batch jobs and current operation
progress. To cancel processing click the Cancel button.

When the batch processincludesimport/export features that are applied to multiple chunksit is reasonable
to use the following templatesin the Path field of the import/export jobs:

« {fil enane} - filename (without extension),

{fileext} -fileextension,
e {camer a} - cameralabdl,

e {frane} -frameindex,

{chunkl abel } - chunk labdl,

» {i magef ol der} - folder containing images of an active chunk,

{projectfol der} - pathto thefolder containing active project,

» {proj ect nane} - active project filename.

Thelist of tasksfor batch processing can be exported to XML structured file using Iltll Save button in the

Batch processing dialog and imported in adifferent project using = Open button.
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4D processing

Overview

PhotoScan supports reconstruction of dynamic scenes captured by aset of statically mounted synchronized
cameras. For this purpose multiple image frames captured at different time moments can be loaded for
each camera location, forming a multiframe chunk. In fact norma chunks capturing a static scene are
multiframe chunks with only a single frame |oaded. Navigation through the frame sequenceis performed
using Timeline pane.

Although aseparate static chunk can be used to process photosfor each time moment, aggregate multiframe
chunks implementation has several advantages:

» Coordinate systems for individual frames are guaranteed to match. There is no need to align chunksto
each other after processing.

» Each processing step can be applied to the entire sequence, with a user selectable framerange. Thereis
no need to use batch processing, which simplifies the workflow.

» Accuracy of photo alignment is better due to the joint processing of photos from the entire sequence.
» Markers can be tracked automatically through the sequence.
* Intuitive interface makes navigation through the sequence pretty simple and fast.

Multiframe chunks can be also efficient (with some limitations) for processing of disordered photo sets of
the same object or even different objects, provided that cameras remain static throughout the sequence.

Managing multiframe chunks

Multiframe layout is formed at the moment of adding photos to the chunk. It will reflect the data layout
used to store image files. Therefore it is necessary to organize files on the disk appropriately in advance.
The following data layouts can be used with PhotoScan:

a. All framesfrom corresponding camera are contained in a separate subfolder. The number of subfolders
is egual to the number of cameras.

b. Corresponding framesfrom all cameras are contained in aseparate subfolder. The number of subfolders
isequal to the number of frames.

c. All frames from corresponding camera are contained in a separate multilayer image. The number of
multilayer imagesis equal to the number of cameras.

d. Corresponding frames from all cameras are contained in a separate multilayer image. The number of
multilayer imagesis equal to the number of frames.

Once the data is properly organized, it can be loaded into PhotoScan to form a multiframe chunk. The
exact procedure will depend on whether the multifolder layout (variants a and b) or multilayer (variants
¢ and d) layout is used.

To create a chunk from multifolder layout

L Select & Add Folder... command from the Workflow menu.
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4,

In the Add Folder dialog box browse to the parent folder containing subfolders with images. Then
click Select Folder button.

In the Add Photos dial og select the suitable datalayout. For layout a) above select " Create multiframe
cameras from folders as cameras'. For layout b) select "Create multiframe cameras from folders as
frames'.

Created multiframe chunk will appear on the Workspace pane.

To create a chunk from multilayer images

1

4.

Select Add Photos... command from the Workflow menu or click Add Photos toolbar button.

In the Add Photos dialog box browse to the folder containing multilayer images and select files to
be processed. Then click Open button.

Inthe Add Photos dial og sel ect the suitable datalayout. For layout ¢) above select " Create multiframe
camerasfromfilesascameras'. For layout d) select " Create multiframe camerasfrom filesasframes”.

Created multiframe chunk will appear on the Workspace pane.

It isrecommended to inspect the loaded frame sequence for errors. This can be done by scrolling the frame
selector in the Timeline pane and inspecting thumbnails in the Photos pane during scrolling.

After multiframe chunk is created, it can be processed in the same way as normal chunks. For multiframe
chunks additional processing parameters allowing to select the range of frames to be processed will be
provided where appropriate.

Tracking markers

PhotoScan allows to automatically track marker projections through the frames sequence, provided that
object position doesn't change significantly between frames. This greatly simplifies the task of labeling of
amoving point if the number of framesislarge.

Totrack markersthrough the frame sequence

1. Scroll frame selector inthe Timeline paneto the 1st frame. Add markersfor the 1st frame as described
in the Setting coordinate system section.

2. Select Track Markers... command from the Tools menu.

3. Adjust the starting and ending frameindicesif necessary. Default val ues correspond to tracking from
the current frame to the end of sequence. Click OK button to start tracking.

4 Check tracked marker locations. Automatically tracked markers will be indicated with “3? icons. In
case of a placement error at some frame, adjust the wrong marker location within the frame where
the failure occurred. Once the marker location is refined by user, the marker icon will changeto “IJ

5. Restart tracking from that frame using Track Markers... command again.

£ Note

* If the ending frame index is smaller than the starting index, tracking will be performed in the
backwards direction.
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« Automatic marker tracking is likely to fail in case when structured light is used to add texture
details to the object surface, as the light pattern will not be static with respect to the moving
object surface.

Python scripting

PhotoScan supports Python API, using Python 3.3 as a scripting engine.
Python commands and scripts can be executed in PhotoScan through one of the following options:

» PhotoScan Console pane can serve as standard Python console;

* Click 4% Run Scri pt button on Console pane toolbar or use & Run Script... command from the Tools
menu to run a Python script.

For details on PhotoScan functionality accessible through Python scripts please refer to Python API
Reference document available on Agisoft official website (http://www.agisoft.com/downloads/user-
manuals/).
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Chapter 8. Network processing

Overview

Agisoft PhotoScan can be configured to run on a computer cluster where processing is distributed on
several computer nodes connected to alocal network. In such configuration multiple PhotoScan instances
running on different processing nodes can work on the same task in parallel, effectively reducing the total
processing time needed.

By default processing is divided between the nodes on a chunk by chunk, frame by frame basis (with the
exception of camera alignment and optimization, where each chunk is processed as a whole on asingle
node). In addition a more fine grained distribution can be enabled for image matching and alignment, as
well as generation of dense clouds, tiled models, DEMs and orthomosaics, in which case processing of
individual chunks/framesis further subdivided between several processing nodes.

Communication between processing nodes, server and clients is performed using TCP connections. In
addition, shared network storage accessible for all processing nodes and clients is used for storing the
source data and intermediate processing results.

Cluster components

Client 1 Processing node 1

Server
TCP TCP

Client 2

\ 4
A

Processing node 2

Client n

Processing node n

Network storage

Server

The server node coordinates operation of all processing nodes, maintaining a task queue for all projects
scheduled for processing. A separate interface is provided for clients, which can connect to the server to
start new processing tasks or monitor progress of existing ones.

The server itself doesn't perform any processing and can easily run on slow hardware. The server
component is critical for operation of the cluster, and is not fault tolerant. Measures should be taken to
ensure continuous operation of the server node.

The server node accepts TCP connections from processing nodes and clients on 2 separate interfaces,
which can be attached to different physical network interfacesif necessary. The server node doesn't initiate
any TCP connections itself.

73



Network processing

Processing nodes

Processing nodes perform actual calculations, and thus need to be run on fast hardware. Each processing
node connects to the server on startup and waits for atask to be assigned. Once the task is available, the
node starts processing, informing the server about the progress. When processing is finished, the results
are stored on shared network storage, and the server isinformed about completion. Then a node switches
to the next task when it becomes available.

Processing nodes can be added or removed from the cluster as needed. Abnormal shutdown of processing
node doesn't cause cluster failure in most cases. Nevertheless, it is highly recommended to stop particular
nodes using Agisoft Network Monitor before disconnecting them from the cluster.

Clients

Clients can connect to the server nodeto control cluster operation or to monitor its status. New tasks can be
submitted for processing using Agisoft PhotoScan software configured as a network client, while cluster
monitoring is performed using Agisoft Network Monitor. Multiple clients can be connected to the server
node simultaneously.

Cluster setup

Before proceeding to the following steps please make sure that shared network storage is accessible from
all processing and client nodes using the same absol ute path. 1t should be either mounted to the same folder
on all nodes (Linux), or should have the same UNC network path (Windows). In case such configuration
isnot possible (for example in mixed Windows/Linux cluster), a path prefix can be specified on each node
to compensate for the differences.

Starting server

It is recommended to configure server with a static |P address, not dynamically assigned one. This IP
address will be needed for each processing node and client.

The server process can be started by executing PhotoScan with the following command line arguments:
photoscan --server --control <ip>[:port] --dispatch <ip>[:port] [--root pr€fiX]

--server parameter specifies that PhotoScan should be started in a server mode.

--contr ol parameter specifiesthe network interface to be used for communication with clients. In case port
value is omitted, the default port 5840 is used.

--dispatch parameter specifiesthe network interface to be used for communication with processing nodes.
In case port value is omitted, the default port 5841 is used.

--root parameter can be used to specify network storage mount point or prefix path in case it is not the
same across network.

Example:
photoscan --server --control 10.0.1.1 --dispatch 10.0.1.1

In this case PhotoScan will use the same interface for both clients and processing nodes with default port
values.

Starting network nodes

The processing node can be started by executing PhotoScan with the following command line arguments:
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photoscan --node --dispatch <ip>[:port] [--r oot prefix]

--node parameter specifies that PhotoScan should be started as a processing node.

--dispatch parameter specifies |P of the server to connect. In case port value is omitted, the default port
5841 is used.

--root parameter can be used to specify network storage mount point or prefix path in case it is not the
same across network.

Example:
photoscan --node --dispatch 10.0.1.1

This command will start processing node using 10.0.1.1 as a server |P with default port 5841.

Checking cluster status

Start Agisoft Network Monitor application. In the host name field enter server IP used for client
connections (10.0.1.1 in our example). Modify port values in case non-default port was specified. Click
Connect button when done.

A list of available network nodes currently connected to the server will be displayed in the bottom part of
the window. Please make sure that all started processing nodes are listed.

Thetop part lists tasks currently being processed (finished tasks are removed from the list as soon as they
are completed). The task list will be empty if no processing was started yet.

Starting network processing

1

Configure Agisoft PhotoScan for network processing.
Start Agisoft PhotoScan on any computer connected to the cluster network.

Open Preferences dialog using Preferences... command from the Tools menu. On the Network tab
make sure Enable network processing option is turned on, and specify the server |P used for client
connection in the Host name field. In case non-default port was configured on a server, modify the
port value accordingly.

In case you are going to process a few single-frame chunks with large number of photos, we
recommend to enable fine-level task distribution for all supported operations (Match Photos, Align
Cameras, Build Dense Cloud, Build Tiled Model, Build DEM, Build Orthomosaic). In case you are
going to process alarge number of small chunks, or chunks with large number of frames, fine-level
task distribution can be left in disabled state.

Press OK button when done.
Prepare project for network processing.

Open the project fileto be processed. Make sure that the project is saved in PhotoScan Project (*.psx)
format. Processing of projectsin PhotoScan Archive (*.psz) format isnot supported in network mode..

Important! Please make sure that source images are located on shared network storage and not on a
local hard drive. Otherwise processing nodes will be unable to load them.

Start processing.
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Start processing using corresponding command from the Workflow menu, or using Batch Process
command to execute a command sequence. A network progress dialog should appear displaying
current progress.

4. Wait for processing to complete.

You can disconnect from the server at any time using Disconnect button in the Network Progress
dialog in case you need to work on other projects. Processing will continue in the background.

To see processing status after you have disconnected from the server simply open corresponding .psx
project on the network storage. Alternatively you can use Agisoft Network Monitor to see processing
status for all projects being processed.

5. Inspect processing results.

After processing is finished, click Close button to close Network Progress dialog. The project with
processing results will be displayed in PhotoScan window.

Cluster administration

Adding processing nodes

New processing nodes can be added by starting Agisoft PhotoScan on additional computersin the network
node mode, as outlined in the Starting network nodes section above.

Removing processing nodes

Aborting or disconnecting processing node during cluster operation is not absolutely safe, and can lead to
project corruption if performed during final project update at the end of processing. Although the chances
of this situation are relatively low, we strongly recommend against such approach. To safely disconnect
processing node from the cluster you need to stop processing on this node using Agisoft Network Monitor
first.

1. Start Agisoft Network Monitor. Make sure the server IPis properly configured in the host namefield
and click Connect button.

2. In the bottom list of network nodes identify the node to be removed. From the node menu select
Pause command to stop the node after it finishes current job, or Stop command to abort processing
immediately.

3. Wait until the Batch # and Progress items for a selected node become empty. This indicates that the
node has finished processing. The status of the node should be Paused.

4.  Now you can safely disconnect the node by aborting PhotoScan process.
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Appendix A. Graphical user interface

Application window

General view

-
B Project.psx — Agisoft PhotoScan

File Edit View Workflow Tools Photo Help
EeE s« RB+AGRE SN QL

Model | IMG_0084.0°G [ | | orthe [£]

= © ()3

points: 91,327,010

Workspace & X | Reference g X
RMEL e X EEE Es0 BEE %
%B Workspace (1 chunks, 415 cameras) Mark;.-rs East err (m) Morth err (m) Alt.er *
4 || Chunk [415 cameras, 29 markers, 806,325 points) [R] B 100 0.010443 0005093 000
i ;ZT;ZT(ESMS aligned) B> g0 0008225 0004656  0.C
28 Tic po: _ [ 70 0018676 0000546  -0.0C
oo Tie Points (806,325 points) Hﬁ 60 -0.020064 0002613 -0.03
828 Dense Cloud (91,327,010 points, Medium quality) ' ' '
4> 3D Model (1,464,956 facel:j e Frso 000735 0023379 04C
% DEM (913,548, 31.7 cm/pbd) L E 30 00L5E 000614 -00C
= o _ W %20 000032 0001162  0.0C
E}hrthomosalcl (3393731797, & cm/pix) 0.005560 0001984  -0.0CE
= Shepes (1 polygens) Total Error 0017687  0.012559  0.00:
4 I 3

[486055.506963 X 6083744580682 ¥ | =

General view of application window.

Model view

Model view tab is used for displaying 3D data as well as for mesh and point cloud editing. The view of
the model depends on the current processing stage and is also controlled by mode selection buttons on

the PhotoScan toolbar.

Model can be shown as a dense cloud, with class indication or without, or as a mesh in shaded, solid,
wireframe or textured mode. Along with the model the results of photo alignment can be displayed. These
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include sparse point cloud and camera positions visualised data. Additionally tiled textured model can be
displayed and navigated in the model view.

PhotoScan supports the following tools for navigation in the 3D view:

Tool Keyboard modifier
Rotation Tool Default

Pan Tool Ctrl key pressed
Zooming Tool Shift key pressed

All navigation tools are accessible in the navigation mode only. To enter the navigation mode click the
+ Navigation toolbar button.

PhotoScan offers two different navigation modes: Object navigation and Terrain navigation. Switching
between the navigation modes can be performed from the Navigation Mode submenu of the View menu.
Object navigation mode allows for 3-axis rotation control, while Terrain navigation mode restricts control
to 2-axis rotation only, z-axis being kept vertical all the time.

In Object navigation mode the rotation with mouse can be performed while left mouse button is pressed,
whereas holding right mouse button allows for model tilt. In Terrain navigation mode mouse buttons
functionality isinverted and left button is responsible for tilt, whereas right button for rotation.

[{ Note

e Zooming into the model can be aso controlled by the mouse whed!.

Ortho view

Ortho view is used for the display of 2D processing results data: digital elevation model, full resolution
orthomosaic, NDVI colour-coded values, as well as shapes and contour lines data. Switching between
DEM and orthomosaic can be performed using the corresponding button on the toolbar or by double-
clicking on the respectiveicon on the Workspace pane, providing that both products have been generated.

Orthomosaic can be displayed intheoriginal coloursor in coloursaccording to the pal ette set for vegetation
index values visualisation.

Additional instruments allow to draw points, polylines and polygons on the orthomosaic and/or digital
elevation model to perform point, linear, profile and volume measurements. Also polygonal shapes are
allowed to be set up as inner or outer boundaries, that will be used for the definition of the area to be
exported. Using polygonal shapes allows to create custom seamlines on the orthomosaic, which can be
useful for some projects enabling to eliminate blending artefacts.

Switching to Ortho view mode changes the contents of the Toolbar, presenting related instruments and
hiding irrelevant buttons.

Photo view

Photo view tab is used for displaying individual photos aswell as markers and masks on them.

Photo view is visible only if any photo is opened. To open a photo double-click on its hame on the
Workspace, Reference or Photos pane.

Switching to Photo view mode changes the contents of the Toolbar, presenting related instruments and
hiding irrelevant buttons.
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Workspace pane

On the Workspace pane all elements comprising the current project are displayed. These elements can
include:

 List of chunksin the project

 List of cameras and camera groups in each chunk
* List of markersin each chunk

* List of scale barsin each chunk

 Tiepointsin each chunk

* Depth maps in each chunk

» Dense point clouds in each chunk

* 3D modelsin each chunk

* Tiled modelsin each chunk

 Digital elevation modelsin each chunk

» Orthomosaicsin each chunk

 Shapesin each chunk

 Elevation contoursin each chunk

Buttons located on the Workspace pane toolbar allow to:

e Add chunk

Add photos

* Add marker

+ Create scale bar

» Enable or disable certain cameras or chunks for processing at further stages.
* Removeitems

Each element in the list is linked with the context menu providing quick access to some common
operations.

Photos pane

Photos pane displays the list of photos/ masksin the active chunk in the form of thumbnails.
Buttons located on the Photos pane toolbar allow to:

+ Enable/ disable certain cameras

* Remove cameras

* Rotate selected photos clockwise / counterclockwise

» Reset current photo filtering option
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* Switch between images and masks thumbnails

* Increase/ decreaseicons size or display detailed information on photos including EXIF data

Console pane

Console paneis used for:

 Displaying auxiliary information
 Displaying error messages

» Python commands input

Buttons located on the pane toolbar allow:
» Savelog

e Clear log

» Execute Python script

Reference pane

Reference paneis designed for:

» Displaying cameraand / or marker coordinates

 Displaying scale bars lengths

» Displaying camera orientations

 Displaying estimation errors

Buttons located on the pane toolbar allow:

 Import / export reference coordinates

» Convert reference coordinates from one system to the other

» Optimize camera alignment and update data

+ Switch between source coordinates, estimated coordinates and errors views

» Specify the coordinate system and measurement accuracy to be assumed through Settings dialog

Timeline pane

Timeline pane is designed for:

» Working with multi-frame chunks
Buttons located on the pane toolbar allow:
+ Add/ remove frames from chunk

» Play / stop frame sequence

» Adjust frame rate through Settings dialog
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4 Note

« To open any pane select a corresponding command from the View menu.

Menu commands

FileMenu
EI New Creates an empty PhotoScan project.
Open... Opens PhotoScan project file.
Append... Appends existing PhotoScan project file to the

HSave

current one.
Saves PhotoScan project file.

Saves PhotoScan project file with a new name.

Save As...
Export Points... Saves sparse / dense point cloud.
Export Model.... Saves 3D model.

Export Tiled Modd...

>{ Delete Selection

t{- Crop Selection

Invert Selection

Grow Selection

Shrink Selection

Saves atiled model as hierarchical tiles.

Exports generated orthomosaic.

Export Orthomosaic...
Export DEM... Exports generated digital elevation model.
Generate Report... S[e)rlw:e;?rﬁe aﬁt\glsoft PhotoScan processing report in
Uploads reconstructed polygona model to one of
Upload Mode... the supported web-sites.
Upload Orthomossic... Uploads generartgd orthomosaic to one of the
supported web-sites.
Exit Quits the application. Prompts to save any unsaved
changes applied to the current project.
Edit Menu
“) Undo Undo the last editing operation.
™ Redo Redo the previously undone editing operation.

Removes selected faces from the mesh or selected
points from the point cloud.

Crops selected faces/ points.
Inverts current selection of faces/ points.

Grows current selection of faces or sparse cloud
points.

Shrinks current selection of faces or sparse cloud
points.
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Edit Menu

Gradual selection...

View Menu

28 Point Cloud

Dense Cloud

#1 Dense Cloud Classes

4> shaded
4> solid
<L Wireframe

“* Textured

¥ Tiled Model
Full Screen

Navigation Mode

82 show Cameras

% show Markers
Show Region
Show Trackball

'@' Show Info

D Show Grid
Show All
Hide All
Predefined views

Perspective/Orthographic
Stereo Mode

** Reset View

Selects faces / points based on the specified
criterion.

Displays sparse point cloud reconstructed during
photo alignment.

Displays dense point cloud.

Displays dense point cloud colored by point
classes.

Displays 3D model in the shaded mode.

Displays 3D model in the solid mode.
Displays 3D model in the wireframe mode.
Displays 3D model in the textured mode.
Displaystiled model.

Switches to / from Full Screen mode.

Switches between Object / Terrain navigation
modes for the Model view window. Object
navigation mode allows for 3-axis rotation control,
while Terrain navigation mode restricts control to
2-axisrotation only, z-axis being kept vertical all
thetime.

Shows or hides camera positions estimated during
image alignment.

Shows or hides marker positions.
Shows or hides region selector.
Shows or hides the trackball.

Shows or hides the mesh information on-screen
display.
Shows or hides the grid related to XY plane.

Shows all elements at the same time.
Hides all elements.
Switches viewport to one of the predefined views.

Switches visualisation view between Perspective
and Orthographic.

Enable/disable stereo view mode according to the
parameters specified in Preferences dial og.

Resets the viewport to display model fully in Top
XY projection.
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View Menu

= Workspace
'8' Timeline
% Reference
Photos

El Console

Toolbar

Wor kflow Menu

Add Photos...
@ Add Folder...

Align Photos...
Build Dense Cloud...
Build Mesh...

Build Texture...

Build Tiled Modd...

Build DEM...

Build Orthomosaic...

Align Chunks...

Merge Chunks...

Batch Process...
ToolsMenu

Detect Markers...

Track Markers...

Print Markers...

Build Point Cloud...

Thin Point Cloud...

Classify Ground Points...

Shows or hides Workspace pane.
Shows or hides Timeline pane.
Shows or hides Reference pane.
Shows or hides Photos pane.
Shows or hides Console pane.

Shows or hides Toolbar.

L oads additional photos to be processed by
PhotoScan.

L oads additiona photos from foldersto be
processed by PhotoScan.

Generates camera positions and sparse point cloud.
Generates dense point cloud.

Generates polygona model.

Generates 3D model texture.

Generates tiled textured model from the dense
cloud.

Generates digital elevation model.

Generates orthomosaic.

Aligns multiple chunks.

Merges multiple chunks into the single chunk.

Opens Batch Process dialog box.

Creates markers from coded targets on photos.

Tracks marker locations across the frame
sequence.

Generates printable PDF file with coded targets.

Builds sparse point cloud based on the estimated
camera parameters available.

Thins sparse point cloud by reducing the number
of projections on the individual photos to the given
limit.

Classifies dense point cloud based on the user
defined settings.
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ToolsMenu
Assign Class...

Reset Classification...

Select Points by Masks...

Select Points by Color...

Decimate Mesh...
Smooth Mesh...

Close Holes...

View Mesh Statistics...

View Mesh UVs...

Measure Area and Volume...

Generate Contours...

Import Cameras...
Import Markers...

Import Masks...
Import Shapes...

Import Mesh...
Import Texture...
Import DEM...
Export Cameras...
Export Markers...
Export Masks...
Export Matches...
Export Shapes...

Export Contours...

Export Texture...

Export Panorama...

Assigns class to the selected points.

Resets assigned classes.

Selects dense cloud points according to the masked

images.

Selects dense cloud points according to the color
and tolerance.

Decimates mesh to the target face count.
Smoothes mesh.

Closes holes on the model surface.

Collects and displays mesh statistics.

Displays mesh UV mapping.

Displays surface area and volume of the model.

Generates contours based on DEM according to
the elevation levels.

Imports camera positions and orientation data.
Imports marker projections.

Imports masks or creates mask from model or
background.

Imports shapes to be used for editing /
measurementsin Ortho view.

Imports edited mesh from the external program.
Imports edited texture from the external program.
Imports digital elevation model.

Exports camera positions and orientation data.
Exports marker projections.

Exports masks.

Exports tie point measurements.

Exports shapes created in Ortho view.

Exports contour lines related to the surface
elevation.

Exports model texture.

Exports spherical panoramafor camera stations.
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ToolsMenu
Export Orthophotos...

Undistort Photos...

42/ Camera Calibration...
Y 4 Optimize Cameras...

Reset Region

"% Preferences...

4¥ Run Script...

Photo Menu
Open Next Photo

Open Previous Photo
Go To Next Marker
Go To Previous Marker

¥¥' Navigation

Pl Rectangle Selection

o Intelligent Scissors
% Intelligent Paint
S Magic Wand

“I Add Selection

Invert Mask
x Reset Mask...
Turn Shading On/Off
% eqit Markers
oo . i
oo View Points

v Image Brightness

Exports separate orthorectified images.

Removes nonlinear distortions by warping source
photos.

Shows camera calibration dialog box.
Shows camera alignment optimization dialog box.

Resets reconstruction volume selector to default
position based on the sparse point cloud.

Shows preferences dialog box.

Opens Python Run Script dialog box.

Opens next photo from the list in the Photos pane.

Opens previous photo from the list in the Photos
pane.

Zooms to the next marker projection on the opened
photo.

Zooms to the previous marker projection on the
opened photo.

Switches to navigation mode.
Rectangle selection tool.
Intelligent Scissors selection tool.
Intelligent Paint selection tool.
Magic Wand selection tool.

Adds current selection to the mask.
Subtracts current selection from the mask.
Inverts current selection.

Inverts mask for the current photo.
Resets mask for the current photo.
Turns mask shading on or off.
Switches to marker editing model.

Shows detected features used for alignment of the
current photo.

Adjusts image brightness for more convenient
display.
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Help Menu
“%¥ Contents

Check for Updates...

Activate Product...

@ About PhotoScan...

Toolbar buttons

General commands
D New
Open

HSave

3D view commands
“} Undo

™ Redo

¥ Navigation

Ll Rectangle Selection
(22 Circle Selection

2 Free-Form Selection
& Resize region

22’ Rotate Region

@ Rotate Object

Pt Delete Selection

tf- Crop Selection

3D view settings

28 Point Cloud

Dense Cloud

#1 Dense Cloud Classes

Displays help contents.

Checks if PhotoScan update is available for
download.

Activates / deactivates the product using the
activation key.

Displays program information, version number and
copyright.

Creates a new PhotoScan project file.
Opens a PhotoScan project file.

Saves a PhotoScan project file.

Undo the last editing operation.

Redo the previously undone editing operation.
Navigation tool.

Rectangle selection tool.

Circle selection tool.

Free-form selection tool.

Volume selection tool.

Volume rotation tool.

Model rotation tool.

Removes selected faces/ points.

Crops selected faces/ points.

Displays sparse point cloud reconstructed during
image alignment.

Displays dense point cloud model.

Displays dense point cloud coloured by point
classes.
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Graphical user interface

3D view settings
4> shaded

4 solid

<> Wireframe

¥ Textured

K% Tiled model

82 show Cameras
l]QP Show Markers

= Show Aligned Chunks

w
*#* Reset View

Photo view commands
“} Undo

™ Redo

¥% Navigation

L Rectangle Selection

¢ Intelligent Scissors
% Intelligent Paint

S Magic Wand

" Add Selection

2 Rotate Right
I Rotate Left
#, Zoom In
=L Zoom out

4 Image Brightness

Turn Shading On/Off

|]3:' Edit Markers

Displays 3D modé in the shaded mode.
Displays 3D model in the solid mode.
Displays 3D model in the wireframe mode.
Displays 3D model in the textured mode.
Displaystiled model.

Shows / hides camera positions, reconstructed
during image alignment.

Shows / hides positions of markers placed on the
model.

Shows/ hides aligned chunks.

Resets model view.

Undo the last mask editing operation.

Redo the previously undone mask editing
operation.

Switches to the navigation mode.
Rectangle selection toal.

Intelligent scissorstool.

Intelligent paint tool.

Magic wand tool.

Adds current selection to the mask.
Subtracts current selection from the mask.
Inverts current selection.

Rotates the photo clockwise.
Rotates the photo counterclockwise.
Increases magnification.

Decreases magnification.

Adjustsimage brightness for more convenient
display.
Turns mask shading on or off.

Switches to marker editing mode.
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Graphical user interface

Photo view commands
oo . .
oo View Points

** Reset View

Ortho view commands
¥ Navigation

4 Draw Point

A Draw Polyline

(] Draw Polygon

% DEM

Orthomosaic

24 Raster Calculator

EE Update Orthomosaic

*, Zoom In
‘=L Zoom Out
& st Brightness

=]
=1 Show Seamlines

= show Shapes

=
2l show Contour Lines
"Q7 Show Markers

** Reset View

Hot keys

General

Create new project
Save project

Load project

Full Screen

Shows/ hides feature points used for alignment of
the photo.

Resets the viewport to display the whole photo.

Switches to the navigation mode.

Switches to the point drawing tool.

Switches to the polyline drawing tool.
Switches to the polygon drawing tool.
Switches to the digital elevation model display
mode.

Switches to the orthomosaic display mode.
Opens Raster Calculator dialog for NVDI and

other vegetation indices calculation.
Applies al the manual edits to the orthomosaic.

Increases the magnification of theimage in the
Ortho view.

Decreases the magnification of theimage in the
Ortho view.

Adjustsimage brightness for more convenient
display.
Displays or hides orthomosaic seamlines.

Displays or hides shapes drawn on the orthomosaic

or elevation model.
Displays or hides contour lines.

Displays or hides marker positions.

Resets the viewport for optimal zoom level of the
image in the Ortho view.

Ctrl + N
Ctrl +S
Ctrl + O
F11
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Graphical user interface

Model View

Undo (only for Delete, Assign Class/ Classify
Ground Points,Masking and Close Holes
operations)

Redo (only for Delete, Assign Class/ Classify
Ground Points,Masking and Close Holes
operations)

Switch between navigation and any other
previously selected mode

Reset view
Switch to stereoview mode

Switch between orthographic and perspective view

modes
Change the angle for perspective view

Assign dense cloud class (only if some points are
selected)

Predefined Views
Top

Bottom
Right

Left

Front

Back

Rotate View
Rotate Up
Rotate Down
Rotate L eft
Rotate Right

Photo View

Next photo (according to Photos pane order)
Previous photo (according to Photos pane order)
Go to the next marker on the same photo

Go to the previous marker on the same photo
Navigation mode

Selection Tools

Rectangle selection

Intelligent scissors

Intelligent paint

Magic wand

Add selection

Ctrl +Z

Ctrl +Y

Space

(&)

Ctrl + mouse whese
Ctrl + Shift+ C

7
Ctrl +7
3
Ctrl +3
1
Ctrl +1

o B~ N

Page Up
Page Down
Tab

Shift + Tab
Y

M
L
p
W

Ctrl + Shift + A
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Graphical user interface

Selection Tools
Subtract selection Ctrl + Shift+ S
Invert selection Ctrl + Shift +1
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Appendix B. Supported formats

Images

Input formats
JPG

TIFF

PNG

BMP
OpenEXR
PGM, PPM
MPO

SEQ

Camera calibration

Import formats

Adgisoft Camera Calibration (*.xml)
Australis Camera Parameters (*.txt)
PhotoModeler Camera Calibration (*.ini)
3DM CaibCam Camera Parameters (* .txt)
CaCam Camera Calibration (*.cal)

USGS Camera Calibration (*.txt)

INPHO Camera Calibration (*.txt)

Camera flight log

GCP

Input for mat

JPG EXIF metadata
Character-separated values (* .txt)
MAVinci CSV (*.csv)
TopoAxistelemetry (*.tel)
C-Astral Bramor log (*.log)

locations

Input format
Character-separated values (* .txt)
Agisoft XML (*.xml)

Undistort formats
JPG

TIFF

PNG

BMP

OpenEXR

Export formats

Agisoft Camera Calibration (*.xml)
Australis Camera Parameters (*.txt)
PhotoModeler Camera Calibration (*.ini)
3DM CadibCam Camera Parameters (*.txt)
CalCam Camera Calibration (*.cal)

USGS Camera Calibration (*.txt)

INPHO Camera Calibration (*.txt)

Estimated positions
Character-separated values (*.txt)
Agisoft XML (*xml)

Estimated positions
Character-separated values (* .txt)
Agisoft XML (*.xml)




Supported formats

Interior and exterior camera orientation

parameters
Import camera positions Export camera positions
Agisoft XML (*.xml) Agisoft XML (*.xml)
BINGO (*.dat) Bundler (*.out)
Bundler (*.out) CHAN files (*.chan)
VisionMap Detailed Report (*.txt) Boujou (*.txt)
Omega Phi Kappa (* .txt)
PATB Exterior Orientation (*.ptb)
BINGO Exterior Orientation (*.dat)
AeroSys Exterior Orientation (*.orn)
INPHO Project File (*.prj)
Tie points
Export matches
BINGO (*.dat)
Import not available ORIMA (*.txt)

PATB (*.ptb)

Sparse/dense point cloud

Export formats
Wavefront OBJ (*.obj)
Stanford PLY (*.ply)
XYZ Point Cloud (*.txt)
ASPRSLAS (*.las)
LAZ (*.l1az)

Import not available ASTM E57 (*.€57)
ASCII PTS (*.pts)
Universal 3D (*.u3d)
potree (*.zip)

Agisoft OC3 (*.oc3)
Topcon CL3 (*.cl3)
Adobe 3D PDF (*.pdf)

Mesh model

Import mesh Export mesh
Wavefront OBJ (*.obj) Wavefront OBJ (*.obj)
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Supported formats

Import mesh

3DS models (*.3ds)
COLLADA (*.dag)

Stanford PLY (*.ply)

STL models (*.stl)
Autodesk DXF (*.dxf)
Autodesk FBX (*.fbx)
Universal 3D models (*.u3d)
OpenCTM models

Texture

Import texture
JPG

TIFF

PNG

BMP
OpenEXR
PGM, PPM

Orthomosaic

Import not available

Import DEM
GeoTIFF elevation (*.tif)

Export mesh

3DS models (*.3ds)
COLLADA (*.dae)

Stanford PLY (*.ply)

STL models (*.stl)
Autodesk DXF (*.dxf)
Autodesk FBX (*.fbx)
Universal 3D models (*.u3d)
VRML models (*.wrl)
Adobe 3D PDF (*.pdf)

Export texture
JPG

TIFF

PNG

BMP
OpenEXR
PGM, PPM

Export orthomosaic
GeoTIFF

JPG

PNG

Google Earth KML/KMZ
Google Map Tiles
MBTiles

World Wind Tiles

Digital elevation model (DSM/DTM)

Export DEM

GeoTIFF elevation (*.tif)

Arc/Info ASCII Grid (*.asc)

Band interleaved file format (*.bil)
XYZ (*.xyz)

Sputnik KMZ (*.kmz)
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Supported formats

Tiled models

Import not available

Shapes and contours

Import shapes
Shape Files (*.shp)
DXF Files (*.dxf)
KML files (*.kml)

Export tiles

Aqgisoft Tiled Model (*.tls)
PhotoMesh Layer (*.zip)
Agisoft Tile Archive (*.zip)

Export shapes/contours
Shape Files (*.shp)

DXF Files (*.dxf)

KML Files (*.kml)
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Appendix C. Camera models

Agisoft PhotoScan supports several parametric lensdistortion models. Specific model which approximates
best a real distortion field must be selected before processing. All models assume a central projection
camera. Non-linear distortions are modeled using Brown's distortion model.

A cameramodel specifiesthe transformation from point coordinatesin the local camera coordinate system
to the pixel coordinatesin the image frame.

Thelocal camera coordinate system has origin at the camera projection center. The Z axis points towards
the viewing direction, X axis pointsto theright, Y axis points down.

The image coordinate system has origin at the top left image pixel, with the center of the top left pixel
having coordinates (0.5, 0.5). The X axis in the image coordinate system points to theright, Y axis points
down. Image coordinates are measured in pixels.

Equations used to project a points in the local camera coordinate system to the image plane are provided
below for each supported camera model.

The following definitions are used in the equations:

(X,Y, Z) - point coordinates in the local camera coordinate system,

(u, v) - projected point coordinates in the image coordinate system (in pixels),
(fx, fy) - foca lengths,

(Cx, Cy) - principal point coordinates,

K1, Ko, K3, K4 - radial distortion coefficients,

Py, Py, P3, P4 - tangential distortion coefficients,

skew - skew coefficient between the x and the y axis,

width - image width in pixels,

height - image height in pixels.

Frame cameras

x=X/Z

y=Y/Z

r = sort(x® + y?)

X' = X(1+ Kqr? + Kor® + Kar® + Kgr®) + (Po(r?+2x%) + 2Pyxy)(1 + Par? + Pyr)
y' = Y(1+ Kar? + Kor* + Kar® + Kar®) + (Py(r2+2y%) + 2Poxy) (1 + Par® + Pyr®)
U=y + Xy +y'skew

V:(:y+y'fy
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Cameramodels

Fisheye cameras
Xo=X1Z
Yo=Y /Z
fo = Sqrt(xo” + o)
X =Xo* tan'rg/ 1o
y=yo* tan'lrg/ 1o
r = sgrt(x? + y?)
X' = X(1+ Kqr? + Kor® + Kar® + Kgr®) + (Po(r?+2x%) + 2Pyxy)(1 + Par? + Pyr?)
Y = y(1+ Kqr? + Kor® + Kar® + Kgr®) + (Py(r*+2y?) + 2Poxy)(1 + Par® + Pyr?)
U= cy + X'fy + y'skew
v=oy+yty

Spherical cameras (equirectangular projection)
U=y +fy * tan'{(X / 2)
v=cy +fy* tan (Y [ sgri(X * X + Z* Z))
where:
Cx = width * 0.5
¢y = height * 0.5
f, = width/ (2* pi)
fy = height / pi
£ Note

» Spherical (equirectangular) camera model doesn't support distortions. All distortions should be
corrected before loading images in PhotoScan.

* In case you are capturing panoramas with a rotated frame/fisheye camera, we recommend to
process original images in PhotoScan using camera station function instead of stitching them in
external software.

Spherical cameras (cylindrical projection)
u=cy+fy* tan}(X / 2)
v=cy+fy* Y /sgrt(X * X +Z* Z)

where:
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Cameramodels

= width* 0.5
¢, = height * 0.5

f, = width/ (2 * pi)
f, = width / (2 * pi)
4 Note

» Spherical (cylindrical) camera model doesn't support distortions. All distortions should be
corrected before loading images in PhotoScan.

 In case you are capturing panoramas with a rotated frame/fisheye camera, we recommend to
process original images in PhotoScan using camera station function instead of stitching them in
external software.
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